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Preface
Lathe Machining easily defines NC programs dedicated to machining 3D cylindrical parts using
2-axis turning and drilling operations, for both horizontal and vertical spindle lathe machines. 

Quick tool path definition is ensured thanks to an intuitive user interface based on graphic
dialog boxes. 
Tools can be easily created and integrated to tool catalogs. Tool path can be generated,
simulated and analyzed. 
Whole manufacturing process is covered from tool path definition to NC data generation thanks
to an integrated postprocessor execution engine. Shop floor documentation is automatically
created in HTML format. 
Finally, associativity with Version 5 design products allows productive design change
management. 

Suitable for all kinds of cylindrical machined parts, Lathe Machining fits the needs of
Fabrication & Assembly industry, as well as all industries where lathe machining techniques are
involved.  
It can be used in shop-floors as a stand-alone product for CAM-centric customers, who will
particularly appreciate the product's ease-of-use and high level of manufacturing capabilities. 
Lathe Machining can be combined with DELMIA products for overall manufacturing process
integration, simulation and optimization, particularly for bigger customers concerned by high
quality and quick time-to-market.

 

Certain portions of this product contain elements subject to copyright owned by the following entities:

© Copyright LightWork Design Ltd., all rights reserved.
© Copyright Deneb Robotics Inc., all rights reserved.
© Copyright Cenit, all rights reserved.
© Copyright Intelligent Manufacturing Software, all rights reserved.
© Copyright WALTER Informationssysteme GmbH, all rights reserved.
© Copyright ICAM Technologies Corporation, all rights reserved.

 



What's New?
Sequential Machining
New: You can now create and manage a sequence of basic Go Standard, Go-Go, Go InDirv,
Go Delta, and Follow tool motions in a single operation called Sequential Machining.
 
General Functions
Enhanced: This product benefits from the enhancements brought to the NC Manufacturing
Infrastructure.
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Getting Started
Before getting into the detailed instructions for using Lathe Machining, this tutorial is intended to
give you a feel of what you can accomplish with the product. 

It provides the following step-by-step scenario that shows you how to use some of the key
functionalities.

Open the Part to Machine
Create a Lathe Roughing Operation

Replay the Toolpath
Create a Lathe Grooving Operation

Create Lathe Profile Finishing Operation
Generate NC Code



Open the Part to Machine
This first task shows you how to open a part, enter the Lathe Machining workbench and make basic modifications
to the Part Operation.
1. Select File > Open then select the Lathe01.CATPart document.

2. Select NC Manufacturing > Lathe Machining from the Start menu.

The Lathe Machining workbench appears.

The part is displayed in the Setup Editor window along with the manufacturing specification tree.
3. Double click Part Operation.1 in the tree to display the Part Operation dialog box.
4. Click the Machine icon, then in the Machine Editor dialog box:

select the Horizontal Lathe Machine icon
make sure that the radial axis is set to X and the spindle axis is set to Z
click OK.

5. Set the tool change point in the Position tab page as shown below.
6. Click OK to confirm your modifications to the Part Operation.
7. Select Manufacturing Program.1 in the tree to make it the current entity.

To insert program entities such as machining operations, tools and auxiliary commands you can either:
make the program current before clicking the insert program entity command
click the insert program entity command then make the program current.
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Create a Lathe Roughing Operation
This task shows you how to create a Longitudinal Roughing operation for machining part
of the workpiece.

This operation will use the tool proposed by the program, so you just need to specify the
geometry to be machined and set some of the machining parameters.
1. Select the Roughing icon .

A Roughing.1 entity along with a default tool is added to the program.
The Roughing dialog box appears directly at the Geometry tab page .

2. Click the red
Stock area in
the icon,
then select
the stock
profile as
shown.

Click OK in
the Edge
Selection
toolbar to
end your
selection.

3. Click the red
Part area in
the icon,
then select
the part
profile as
shown.

Click OK in
the Edge
Selection
toolbar to
end your
selection.



4. Select the
Strategy tab
page 
and set the
parameters
as shown.

5. Click OK to create the operation.

 

  



Replay the Tool Path
This task shows you how to replay the tool path of the Roughing operation.

1. Select the
Roughing
operation
in the tree
then
select the
Replay
Tool Path
icon .

The
Replay
dialog box
appears.

2. Choose
the
Continuous
replay
mode by
means of
the drop
down icon

 .

3. Click the  button to position the tool at the start point of the operation. 

4. Click the  button to start  the replay. The tool moves along the computed trajectory.

5. Click OK to quit the replay mode.

 

  



Create a Lathe Grooving Operation
This task shows you how to create a Grooving operation to machine part of the
workpiece.

You will specify the geometry to be machined, set some of the machining parameters
and select a new tool.
Make sure that the Roughing operation is the current entity in the program.

1.
Select the Grooving icon .

The Grooving dialog box appears directly at the Geometry page .
2. Click the red Stock area in the icon, then select the stock profile as shown.
3. Click the red Part area in the icon, then select the groove profile as shown.

4. Select the Strategy tab page  and check machining parameters.  Set the
Gouging Safety Angle to 10 degrees.

 5.
Select the Tool tab  in the Tool Assembly tab page.

Enter a name of the new tool (for example, Grooving Tool).
Double click the l2 (shank length 2) parameter in the icon, then enter 60mm in
the Edit Parameter dialog box.
Set the Max cutting depth Technology parameter to 80mm.



6. Click Replay in the dialog box to visually check the operation's tool path.

Click OK to exit the replay mode and return to the Grooving dialog box.
7. Click OK to create the operation.

 

  



Create a Lathe Profile Finishing
Operation

This task shows you how to insert a Profile Finishing operation in the program.

1. Select the Profile Finishing icon .

The Profile Finishing dialog box appears directly at the Geometry page .

2. Select the red part in the sensitive icon then select the part profile.
3. Select the Strategy tab page  and set the Leading Safety Angle to 0 degrees. 

4. Click Replay to replay the operation as described previously. 



Click OK to exit the replay mode and return to the Profile Finishing dialog box.
5. Click OK to create the operation in the program. 

 

  



Generate NC Code
This task shows you how to generate NC code from the program. An APT source file will
be generated in this example.

Before doing this task, double click the Part Operation entity in the tree and, in the dialog
box that appears, click the Machine icon to access the Machine Editor dialog box. Make
sure that you have selected a Horizontal lathe machine and that the desired NC data
format is set to Axis (X, Y, Z).
1. Use the right

mouse key on
the
Manufacturing
Program.1 entity
in the tree to
select Generate
NC Code
Interactively.

The Save NC
File dialog box
appears.

2. Select the folder
where you want
the file to be
saved and
specify the name
of the file.

3. Click Save to create the APT source file.
Here is an extract from the Apt source file that could be generated:
$$ -----------------------------------------------------------------
$$ Generated on Tuesday, May 15, 2001 05:14:58 PM
$$ -----------------------------------------------------------------
$$ Manufacturing Program.1
$$ Part Operation.1
$$*CATIA0
$$ Manufacturing Program.1
$$ 1.00000 0.00000 0.00000 0.00000
$$ 0.00000 1.00000 0.00000 0.00000
$$ 0.00000 0.00000 1.00000 0.00000
PARTNO PART TO BE MACHINED
COOLNT/ON
CUTCOM/OFF
PPRINT OPERATION NAME : Lathe Tool Change.1
$$ Start generation of : Lathe Tool Change.1
TLAXIS/ 0.000000, 0.000000, 1.000000
$$ TOOLCHANGEBEGINNING



RAPID
GOTO / 125.00000, 0.00000, 275.00000
CUTTER/ 5.000000
TOOLNO/0,TURN
$$ End of generation of : Lathe Tool Change.1
PPRINT OPERATION NAME : Roughing.1
$$ Start generation of : Roughing.1
FEDRAT/ 0.3000,MMPR
SPINDL/ 70.0000,RPM
GOTO / 107.02703, 0.00000, 257.00000
GOTO / 107.02703, 0.00000, 255.00000
...
FEDRAT/ 0.8000,MMPR
GOTO / 0.21213, 0.00000, 225.21213
$$ End of generation of : Roughing.1
CUTCOM/OFF
$$ ------ CUTCOM OFF END OF LATHE ------
PPRINT OPERATION NAME : Lathe Tool Change.2
$$ Start generation of : Lathe Tool Change.2
$$ TOOLCHANGEBEGINNING
RAPID
GOTO / 125.00000, 0.00000, 275.00000
CUTTER/ 1.200000
TOOLNO/0,TURN
$$ End of generation of : Lathe Tool Change.2
PPRINT OPERATION NAME : Grooving.1
$$ Start generation of : Grooving.1
FEDRAT/ 0.3000,MMPR
SPINDL/ 70.0000,RPM
GOTO / 108.20000, 0.00000, 111.70000
GOTO / 106.20000, 0.00000, 111.70000
...
RAPID
GOTO / 108.20000, 0.00000, 57.91213
$$ End of generation of : Grooving.1
CUTCOM/OFF
$$ ------ CUTCOM OFF END OF LATHE ------
PPRINT OPERATION NAME : Lathe Tool Change.3
$$ Start generation of : Lathe Tool Change.3
$$ TOOLCHANGEBEGINNING
RAPID
GOTO / 125.00000, 0.00000, 275.00000
CUTTER/ 5.000000
TOOLNO/0,TURN
$$ End of generation of : Lathe Tool Change.3
PPRINT OPERATION NAME : Profile Finishing.1
$$ Start generation of : Profile Finishing.1
FEDRAT/ 0.3000,MMPR
SPINDL/ 70.0000,RPM
GOTO / 27.12132, 0.00000, 224.94975
GOTO / 28.53553, 0.00000, 223.53553
...
FEDRAT/ 0.8000,MMPR
GOTO / 100.21213, 0.00000, 4.78787
$$ End of generation of : Profile Finishing.1
SPINDL/OFF



REWIND/0
END

 

 



Basic Tasks
The basic tasks you will perform with Lathe Machining involve creating, editing and managing
machining operations and other entities of the NC manufacturing process.

Lathe Machining Operations
Axial Machining Operations

Manufacturing Entities
Auxiliary Operations

Verification, Simulation and Program Output
Part Operations, Programs and Processes

 



Lathe Machining Operations
The tasks in this section show you how to create lathe machining operations in your
manufacturing program.

Create a Roughing operation:
Select the Roughing icon and choose the desired roughing mode. You can then
select the part and stock geometry and specify the tool to be used. Specify
machining parameters, feeds and speeds, and NC macros as needed.

Basic tasks illustrate the following roughing modes:
Longitudinal
Face
Parallel Contours.

Create a Recessing operation:
Select the Recessing icon and choose the desired recessing mode. You can then
select the part and stock geometry and specify the tool to be used. Specify
machining parameters, feeds and speeds, and NC macros as needed.
Create a Grooving operation:
Select the Grooving icon then select the part and stock geometry and specify the tool
to be used. Specify machining parameters, feeds and speeds, and NC macros as
needed.
Create a Profile Finishing operation:
Select the Profile Finishing icon then select the part profile and specify the tool to be
used. Specify machining parameters, feeds and speeds, and NC macros as needed.
Create a Groove Finishing operation:
Select the Groove Finishing icon then select the part geometry and specify the tool to
be used. Specify machining parameters, feeds and speeds, and NC macros as
needed.
Create a Threading operation:
Select the Threading icon and choose the desired thread type. You can then select
the part geometry and specify the tool to be used. Specify machining parameters,
feeds and speeds, and NC macros as needed.
Create a Sequential Machining operation:
Create and manage a sequence of basic Go Standard, Go-Go, Go InDirv, Go Delta,
and Follow tool motions in a single operation.
Manage Local Information:
Assign local feedrates and local thicknesses to Profile Finishing and Groove
Finishing operations.

 



 



Create a Longitudinal Roughing Operation
This task illustrates how to create a Longitudinal Roughing operation in the program. 

To create the operation you must define:
the geometry to be machined 

the tool that will be used 

the parameters of the machining strategy 

the feedrates and spindle speeds 

the macros (transition paths) .

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining from the
Start menu. Make the Manufacturing Program current in the specification tree.  
1. Select the Roughing icon .

A Roughing entity along with a default tool is
added to the program.
The Roughing dialog box appears directly at the
Geometry tab page . 

This tab page includes a sensitive icon to help
you specify the geometry to be machined.

The part and stock of the icon are colored red
indicating that this geometry is required. All
other geometry is optional. 

2. Click the red part in the icon then select the desired part profile in the 3D window.
The Edge Selection toolbar appears to help you with contour selection: 

The Auto-link command allows you to select a first element then the element to Navigate to in
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order to complete the profile selection.

The Axial/Radial, Radial/Axial, and Direct commands are also useful for profile selection.

The part of the icon is now colored green indicating that this geometry is now defined.

3. Click the red stock in the icon then select the desired stock profile in the 3D window.
4.  Double click Thickness on Part in the icon. 

Set this value to 5mm in the Edit Parameter dialog box and click OK.
5. Select the Strategy tab page  to specify

the main machining strategy parameters:
Roughing mode: Longitudinal
Orientation: External
Location: Front.

 

6. Double click Max depth of cut in the icon. 

Set this value to 15mm in the Edit Parameter
dialog box and click OK.

Other optional parameters can be set in the
Options tab page (lead-in and so on). 

A tool is proposed by default when you want to create a machining operation. If the proposed tool
is not suitable, just select the Tool tab page  to specify the tool you want to use. Please refer
to Edit the Tool of a Lathe Operation.

7. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds for the
operation. See Feeds and Speeds for Roughing for more information.



8. Select the Macros tab page  to specify the operation's transition paths (approach and retract
motion, for example). See Define Macros on a Lathe Operation for an example. 
Before accepting the operation, you should check its validity by replaying the tool path.

9. Click OK to create the operation.
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Create a Face Roughing Operation
This task shows how to insert a Face Roughing operation in the program.

To create the operation you must define:
the geometry to be machined 

the tool that will be used 

the parameters of the machining strategy 

the feedrates and spindle speeds 

the macros (transition paths) .

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining
from the Start menu.  Make the Manufacturing Program current in the specification tree.  
1. Select the Roughing icon .

The Roughing dialog box
appears directly at the Geometry
tab page . 
This page includes a sensitive
icon to help you specify the
geometry to be machined.

The part and stock in the icon are
colored red indicating that this
geometry is required for defining
the operation. 

2. Click the red part in the icon then select the desired part profile in the 3D window.
The part of the icon is now colored green indicating that this geometry is now
defined.

3. Click the red stock in the icon then select the desired stock profile in the 3D window.
4.  Double click Thickness on Part in the icon. 

Set this value to 5mm in the Edit Parameter dialog box and click OK.
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5. Select the Strategy tab page
 to specify the main

machining strategy parameters:
Roughing mode: Face
Orientation: External
Location: Front.

6. Double click Max depth of cut in
the icon. 

Set this value to 10mm in the Edit
Parameter dialog box and click
OK.

7 In the Options tab page, set the
lift-off distance to 1.5mm. 

A tool is proposed by default when you want to create a machining operation. If the
proposed tool is not suitable, just select the Tool tab page  to specify the tool
you want to use. This is described in Edit the Tool of a Lathe Operation.

8. Select the Feeds and Speeds tab page  to specify the feedrates and spindle
speeds for the operation. See Feeds and Speeds for Roughing for more information.
If you want to specify approach and retract motion for the operation, select the
Macros tab page  to specify the desired transition paths. See Define Macros
on a Lathe Operation for an example. 

9. Check the validity of the
operation by replaying the tool
path.
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10. Click OK to create the operation.

 

  



Create a Parallel Contour Roughing
Operation

This task shows how to insert a Parallel Contour Roughing operation in the program.

To create the operation you must define:
the geometry to be machined 

the tool that will be used 

the parameters of the machining strategy 

the feedrates and spindle speeds 

the macros (transition paths) .

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining
from the Start menu. Make the Manufacturing Program current in the specification tree.  

1. Select the Roughing icon .

A Roughing entity along with a
default tool is added to the
program.

The Roughing dialog box appears
directly at the Geometry tab page

. 
This tab page includes a sensitive
icon to help you specify the
geometry to be machined. 

The part and stock of the icon are colored red indicating that this geometry is
required.

2. Click the red part in the icon, then select the desired part profile in the 3D window.

Select the stock in the same way.
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3. Select the Strategy tab page
 to specify the main

machining strategy parameters:
Roughing mode: Parallel
Contour
Orientation: External
Location: Front
Machining direction: To
head stock.

4. Double click Axial depth of cut in
the icon. 

Set this value to 3mm in the Edit
Parameter dialog box and click
OK.

Set Radial depth of cut to 3mm
in the same way.

Other optional parameters can be
set in the Options tab page
(lead-in and so on).
A tool is proposed by default when you want to create a machining operation. If the
proposed tool is not suitable, just select the Tool tab page  to specify the tool
you want to use. This is described in Edit the Tool of a Lathe Operation.

5. Select the Feeds and Speeds tab page  to specify the feedrates and spindle
speeds for the operation. See Feeds and Speeds for Roughing for more information.

6. If you want to specify approach and retract motion for the operation, select the
Macros tab page  to specify the desired transition paths. See Define Macros on
a Lathe Operation for an example. 
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Before accepting the operation, you should check its validity by replaying the tool
path.

7. Click OK to create the operation.
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Create a Recessing Operation
This task shows how to insert a Recessing operation in the program.

To create the operation you must define:
the geometry to be machined 

the tool that will be used 

the parameters of the machining strategy 

the feedrates and spindle speeds 

the macros (transition paths) .

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining
from the Start menu. Make the Manufacturing Program current in the specification tree.  
1. Select the Recessing icon .

A Recessing entity along with a
default tool is added to the
program.
The Recessing dialog box appears
directly at the Geometry tab page

. 

This tab page includes a sensitive
icon to help you specify the
geometry to be machined.

The part and stock in the icon are colored red indicating that this geometry is
required.  

2. Click the red part in the icon then select the desired part profile in the 3D window.

Select the stock in the same way.
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3. Select the Strategy tab page 
to specify the main machining
strategy parameters:

Recessing mode: Zig zag
Orientation: External
Machining direction: To
head stock.

4. Double click Max depth of cut in
the icon. 

Set this value to 10mm in the Edit
Parameter dialog box and click
OK.

Other optional parameters can be
set in the Options tab page (lead-in
and so on).

A tool is proposed by default when you want to create a machining operation. If the
proposed tool is not suitable, just select the Tool tab page  to specify the tool
you want to use. This is described in Edit the Tool of a Lathe Operation.

5. Select the Feeds and Speeds tab page  to specify the feedrates and spindle
speeds for the operation. See Feeds and Speeds for Recessing for more information.

6. If you want to specify approach and retract motion for the operation, select the
Macros tab page  to specify the desired transition paths. See Define Macros on
a Lathe Operation for an example. 
Before accepting the operation, you should check its validity by replaying the tool
path.

 
7. Click OK to create the operation.
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Create a Grooving Operation
This task shows how to insert a Grooving operation in the program.

To create the operation you must define:
the geometry to be machined 

the tool that will be used 

the parameters of the machining strategy 

the feedrates and spindle speeds 

the macros (transition paths) .

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining
from the Start menu.  Make the Manufacturing Program current in the specification tree.  
1. Select the Grooving icon .

The Grooving dialog box appears
directly at the Geometry tab page

. 
This page includes a sensitive icon
to help you specify the geometry to
be machined.
The part and stock in the icon are
colored red indicating that this
geometry is required for defining
the operation. 

2. Click the red part in the icon, then
select the desired part profile in the
3D window. 

Select the stock in the same way.
The part and stock of the icon are now colored green indicating that this geometry is
now defined.
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3. Select the Strategy tab page 
to specify the main machining
strategy parameters:

Orientation: External
First plunge position:
Center
Next plunges position: To
head stock.

4. Double click Max depth of cut in
the icon. 

Set this value to 10mm in the Edit
Parameter dialog box and click
OK.

Other optional parameters can be
set in the Options tab page (lead-in
and so on).

A tool is proposed by default when you want to create a machining operation. If the
proposed tool is not suitable, just select the Tool tab page  to specify the tool
you want to use. This is described in Edit the Tool of a Lathe Operation.

5. Select the Feeds and Speeds tab page  to specify the feedrates and spindle
speeds for the operation.  See Feeds and Speeds for Grooving for more information.
You can add approach and retract motions to the operation in the Macros tab page

. See Define Macros on a Lathe Operation for an example. 

6. Check the validity of the operation by replaying the tool path.

 
7. Click OK to create the operation.
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Create a Profile Finishing Operation
This task shows how to insert a Profile Finishing operation in the program.

To create the operation you must define:
the geometry to be machined 

the tool that will be used 

the parameters of the machining strategy 

the feedrates and spindle speeds 

the macros (transition paths) .

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining
from the Start menu. Make the Manufacturing Program current in the specification tree.  
1. Select the Profile Finishing icon

.

The Profile Finishing dialog box
appears directly at the Geometry
tab page . 
This page includes a sensitive icon
to help you specify the geometry to
be machined.

The part in the icon is colored red
indicating that this geometry is
required for defining the operation. 

2. Click the red part in the icon, then
select the desired part profile in the
3D window.
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In addition to the global offsets and thicknesses that you can assign to the selected
profile, you can also add local offsets and thicknesses. 

Right click the geometry to be assigned the local value, and select the Add Local
Information contextual command. A dialog box appears allowing you to assign the
desired local values.

It is possible to locally invert the machining direction.

Other contextual commands are available for analyzing and resetting local
information.  

Please refer to Local Information for more details. 
The part of the icon is now colored green indicating that this geometry is now defined.

4. Select the Strategy tab page 
to specify the main machining
strategy parameters:

Orientation: External
Location: Center
Select the Recess
machining checkbox
Machining direction is set
automatically To spindle.

Note that you can locally invert
machining directions using Local
Information facilities.

Other optional parameters can be
set in the Machining and Corner
processing tab pages.

A tool is proposed by default when you want to create a machining operation. If the
proposed tool is not suitable, just select the Tool tab page  to specify the tool
you want to use. This is described in Edit the Tool of a Lathe Operation.

5. Select the Feeds and Speeds tab page  to specify the feedrates and spindle
speeds for the operation. See Feeds and Speeds for Profile Finishing for more
information.



In addition to the global feedrates that you can assign for the operation, you can also
add local feedrates to portions of the profile. 

Right click the geometry to be assigned the local value, and select the Add Local
Information contextual command. A dialog box appears allowing you to assign the
desired local values.

Other contextual commands are available for analyzing and resetting local
information.  

Please refer to Local Information for more details. 
You can add approach and retract motions to the operation in the Macros tab page

. See Define Macros on a Lathe Operation for an example. 

6. Check the validity of the operation by replaying the tool path.
7. Click OK to create the operation.
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Create a Groove Finishing Operation
This task shows how to insert a Groove Finishing operation in the program. 

To create the operation you must define:
the geometry to be machined 

the tool that will be used 

the parameters of the machining strategy 

the feedrates and spindle speeds 

the macros (transition paths) .

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining
from the Start menu. Make the Manufacturing Program current in the specification tree.  
1. Select the Groove Finishing icon

.

A Groove Finishing entity along
with a default tool is added to the
program.
The Groove Finishing dialog box
appears directly at the Geometry
tab page . 

This tab page includes a sensitive
icon to help you specify the
geometry to be machined.
The part in the icon is colored red
indicating that this geometry is
required. 

2. Click the red part in the icon then
select the desired part profile in
the 3D window.
In addition to the global offsets and thicknesses that you can assign to the selected
profile, you can also add local offsets and thicknesses. 

Right click the geometry to be assigned the local value, and select the Add Local
Information contextual command. A dialog box appears allowing you to assign the
desired local values.

Other contextual commands are available for analyzing and resetting local
information.  

Please refer to Local Information for more details.
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3. Select the Strategy tab page
  

to specify the main machining
strategy parameters:

Orientation: External
Machining direction: To
head stock
Contouring for outside
corners: Circular.

Other optional parameters can be
set in the Machining and Corner
processing tab pages.

A tool is proposed by default when you want to create a machining operation. If the
proposed tool is not suitable, just select the Tool tab page  to specify the tool
you want to use. This is described in Edit the Tool of a Lathe Operation.

4. Select the Feeds and Speeds tab page  to specify the feedrates and spindle
speeds for the operation. See Feeds and Speeds for Finish Grooving for more
information.
In addition to the global feedrates that you can assign for the operation, you can also
add local feedrates to portions of the profile. 

Right click the geometry to be assigned the local value, and select the Add Local
Information contextual command. A dialog box appears allowing you to assign the
desired local values.

Other contextual commands are available for analyzing and resetting local
information. 

Please refer to Local Information for more details.
5. Select the Macros tab page  to specify the operation's transition paths

(approach and retract motion, for example). See Define Macros on a Lathe Operation
for an example. 
Before accepting the operation, you should check its validity by replaying the tool
path.

6. Click OK to create the operation.
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Create a Threading Operation
This task shows how to insert a Threading operation in the program. 

To create the operation you must define:
the geometry to be machined 

the tool that will be used 

the parameters of the machining strategy 

the feedrates and spindle speeds 

the macros (transition paths) .

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining
from the Start menu. Make the Manufacturing Program current in the specification tree.  
1. Select the Threading icon .

A Threading entity along with a
default tool is added to the
program.
The Threading dialog box appears
directly at the Geometry tab page

. 

This tab page includes a sensitive
icon to help you specify the
geometry to be machined.
The part in the icon is colored red
indicating that this geometry is
required.

2. Click the red part in the icon then
select the desired part profile in the
3D window.

3. Double click Length in the icon then
specify the desired length of
threading in the Edit Parameters
dialog box that appears.
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4. Select the Strategy tab page 
to specify the main machining
parameters that are organized in
three tabs: Thread, Strategy and
Options. 

Set the following values in the
Thread tab:

Profile: Other
Orientation: External
Location: Front
Thread unit: Pitch
Number of threads: 1
Thread depth: 10mm
Thread pitch: 10mm.

Other optional parameters can be
set in the Strategy and Options
tabs.

5. If you want to generate CYCLE statements, you must select the Output CYCLE
syntax checkbox in the Options tab and set the Syntax Used option to Yes in the NC
Output generation dialog box.
Otherwise, GOTO statements will be generated. 
A tool is proposed by default when you want to create a machining operation. If the
proposed tool is not suitable, just select the Tool tab page  to specify the tool
you want to use. This is described in Edit the Tool of a Lathe Operation.

6. Select the Feeds and Speeds tab page  to specify the machining spindle speed
for threading.

7. Select the Macros tab page  to specify the operation's transition paths
(approach and retract motion, for example). See Define Macros on a Lathe Operation
for an example. 
Before accepting the operation, you should check its validity by replaying the tool
path.

8. Click OK to create the operation.
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Example of output

If your PP table is customized with the following statement for Lathe Threading
operations:

CYCLE/THREAD,%MFG_THREAD_PITCH

A typical NC data output is as follows:

CYCLE/THREAD, 10.000000

The parameters available for PP word syntaxes for this type of operation are
described in the NC_LATHE_THREADING section of the Manufacturing
Infrastructure User's Guide.
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Create a Sequential Machining Operation
This task illustrates how to create a Sequential Machining operation in the program. 

To create the operation you must define:
the list of motions making up the operation 

the tool that will be used 

the feedrates and spindle speeds 

the macros (transition paths) .

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining
from the Start menu. Make the Manufacturing Program current in the specification tree.  
1. Select the Sequential Machining icon .

A Sequential Machining entity along with a default tool is added to the program.
The dialog box appears directly at the List of Motions tab page . 

The first motion must be a Go motion to a point or a Go motion with two check elements.

2. Select the Go icon .

The dialog box for defining the first motion appears. 

In the Geometry tab:
Successively select the two check elements in the dialog box then the desired
check elements in the 3D view.
Set the first and second check modes To a curve.
Set a thickness on the first check element to 2mm.
Click OK to define the motion.
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3. Select the Go icon  again to define the second motion.

In the Geometry tab:
Select a check element in the dialog box then the desired check element in the 3D
view.
Set the check mode to Past a curve.
Set a thickness on the check element to 5mm.
Click OK to define the motion.

 



4.
Select the Go InDirv icon . 

In the Geometry tab:
Select the drive direction in the dialog box then the desired linear element in the
3D view.
Set the check mode to To a curve.
Click OK to define the motion.

5.
Select the Follow icon . 

In the Geometry tab:
Select the drive curve in the dialog box then the desired drive element in the 3D
view.
Set the check mode to On a curve.
Click OK to define the motion.



6.
Select the PP word icon , then specify a PP word in the dialog box that appears
(DELAY/5, for example).

7.
Select the Go Delta icon . 

In the Geometry tab:
Set the check mode to Line and distance.
Select the delta element in the dialog box then the desired linear element in the 3D
view.
Enter a distance.
Click OK to define the motion.



Other optional parameters can be set in the Strategy tab page for each of the motions. 



A tool is proposed by default when you want to create a machining operation. If the
proposed tool is not suitable, just select the Tool tab page  to specify the tool you
want to use. Please refer to Edit the Tool of a Lathe Operation.

8. Select the Feeds and Speeds tab page  to specify the feedrates and spindle
speeds for the operation. See Feeds and Speeds for Roughing for more information.



9. Select the Macros tab page  to specify the operation's transition paths (approach
and retract motion, for example). See Define Macros on a Lathe Operation for an
example. 
Before accepting the operation, you should check its validity by replaying the tool path.

10. Click OK to create the operation.
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Manage Local Information
This task illustrates how to manage Local Information (local feedrates and thicknesses) on a Profile Finishing
or Groove Finishing operation. 

To create Local Information, you must define the geometry to be machined .

Create a Profile Finishing operation in the program.
In the Profile Finishing dialog box that appears, select the Geometry tab page . 

Local Information can be added on lines, arcs and curves if they are part of a finished profile.
Click the red part in the icon then select the desired finish profile in the 3D window.



To create or edit local information
To add local information on an element, right click on it and select "Add Local Information" in the contextual
menu.

To edit Local Information from an element, right click on it and select "Edit Local Information" in the contextual
menu.

In both cases, set the information you want and validate with "OK".

To copy the local information of an element and paste it on another element of the finish profile, right click on it
and select "Copy Local Information" in the contextual menu, then right click on the target element and select
"Paste Local Information".

In the Local Information Browser, you can edit local information by double clicking on the row of the list you are
interested in.

To copy local information from an element and paste it on another element of the finished profile, select an
element in the list of the Local Information Browser and select the information you want to copy in the
right-frame. Then click "Paste on..." and select the target element.
Local information is associated to the selected profile and is supported by that profile. If you delete the profile,
the associated information is also deleted.

To view local information
To browse local information on a finished body, right click on an element of the finished body or on the
representation of the Part Body in the Geometry tab, then select "Browse Local Information". 

In the Local Information Browser, you can see on the 3D view of the finished body defined local information by
clicking on the column header.

To remove local information
To remove Local Information from an element, right click on it and select "Remove Local Information" in the
contextual menu.

In the Local Information Browser, click on the local information you want to delete and click Remove.

Options for Inverted Element (for Profile Finishing only)



The inversion of elements is possible for Profile Finishing operations. This is illustrated in the figure below:

In the Strategy tab page, click on the Local Invert tab.

To machine part with inverted elements, several strategies are available:
None: the profile is machined with inverted ways of machining.
Thickness: a given thickness is let on inverted element and the remaining material is removed when
the inverted element is machined again.
Overlap: a given length of an element is machined twice when the profile is machined and then when
inverted elements are machined. In this case, you can choose to machine inverted elements first or
later.

The lift-off can be linear or circular as specified in the Machining tab.

 



 



Axial Machining Operations
The tasks for creating axial machining operations are documented in the Prismatic Machining
User's Guide.

Spot Drilling Operation
Create a Spot Drilling Operation: Select the Spot Drilling icon then select the hole or
hole pattern to be machined and specify the tool to be used. Specify machining
strategy parameters, macros and feeds and speeds as needed.

Drilling Operations
Create a Drilling Operation: Select the Drilling icon then select the hole or hole
pattern to be machined and specify the tool to be used. Specify machining strategy
parameters, macros and feeds and speeds as needed.
Create a Drilling Dwell Delay Operation: Select the Drilling Dwell Delay icon then
select the hole or hole pattern to be machined and specify the tool to be used.
Specify machining strategy parameters, macros and feeds and speeds as needed.
Create a Drilling Deep Hole Operation: Select the Drilling Deep Hole icon then select
the hole or hole pattern to be machined and specify the tool to be used. Specify
machining strategy parameters, macros and feeds and speeds as needed.
Create a Drilling Break Chips Operation: Select the Drilling Break Chips icon then
select the hole or hole pattern to be machined and specify the tool to be used.
Specify machining strategy parameters, macros and feeds and speeds as needed.

Hole Finishing Operations
Create a Reaming Operation: Select the Reaming icon then select the hole or hole
pattern to be machined and specify the tool to be used. Specify machining strategy
parameters, macros and feeds and speeds as needed.
Create a Counterboring Operation: Select the Counterboring icon then select the
hole or hole pattern to be machined and specify the tool to be used. Specify
machining strategy parameters, macros and feeds and speeds as needed.

Boring Operations
Create a Boring Operation: Select the Boring icon then select the hole or hole pattern
to be machined and specify the tool to be used. Specify machining strategy
parameters, macros and feeds and speeds as needed.
Create a Boring Spindle Stop Operation: Select the Boring Spindle Stop icon then
select the hole or hole pattern to be machined and specify the tool to be used.
Specify machining strategy parameters, macros and feeds and speeds as needed.
Create a Boring and Chamfering Operation: Select the Boring and Chamfering icon
then select the hole or hole pattern to be machined and specify the tool to be used.
Specify machining strategy parameters, macros and feeds and speeds as needed.
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Create a Back Boring Operation: Select the Back Boring icon then select the hole or
hole pattern to be machined and specify the tool to be used. Specify machining
strategy parameters, macros and feeds and speeds as needed.

Threading Operations
Create a Tapping Operation: Select the Tapping icon then select the hole or hole
pattern to be machined and specify the tool to be used. Specify machining strategy
parameters, macros and feeds and speeds as needed.
Create a Reverse Threading Operation: Select the Reverse Threading icon then
select the hole or hole pattern to be machined and specify the tool to be used.
Specify machining strategy parameters, macros and feeds and speeds as needed.
Create a Thread without Tap Head Operation: Select the Thread without Tap Head
icon then select the hole or hole pattern to be machined and specify the tool to be
used. Specify machining strategy parameters, macros and feeds and speeds as
needed.
Create a Thread Milling Operation: Select the Thread Milling icon then select the hole
or hole pattern to be machined and specify the tool to be used. Specify machining
strategy parameters, macros and feeds and speeds as needed.

Countersinking and Chamfering Operations
Create a Countersinking Operation: Select the Countersinking icon then select the
hole or hole pattern to be machined and specify the tool to be used. Specify
machining strategy parameters, macros and feeds and speeds as needed.
Create a Chamfering Two Sides Operation: Select the Chamfering Two Sides icon
then select the hole or hole pattern to be machined and specify the tool to be used.
Specify machining strategy parameters, macros and feeds and speeds as needed.

T-Slotting and Circular Milling
Create a T-Slotting Operation: Select the T-Slotting icon then select the hole or hole
pattern to be machined and specify the tool to be used. Specify machining strategy
parameters, macros and feeds and speeds as needed.
Create a Circular Milling Operation: Select the Circular Milling icon then select the
hole or hole pattern to be machined and specify the tool to be used. Specify
machining strategy parameters, macros, and feeds and speeds as needed.
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Managing Manufacturing Entities
Tasks involving manufacturing entities that are specific to the Lathe Machining product can be
found in this section.

Edit the Tool of a Lathe Machining Operations
Edit a Lathe Tool in the Resource List

Edit a Lathe Tool Assembly in the Resource List
Edit a Lathe Insert in the Resource List

The tasks for creating and managing specific entities of the NC manufacturing environment are
documented in the NC Manufacturing Infrastructure User's Guide.

Edit the Tool of a Milling or Drilling Operation: Double click the machining operation in
the program and select the Tool tab page to edit the characteristics or search for a new
tool.
Edit a Mill or Drill Tool in the Resource List: Double click a tool referenced in the
resource list and edit the characteristics in the Tool Definition dialog box.
Edit a Mill or Drill Tool Assembly in the Resource List: Double click a tool assembly
referenced in the resource list and edit the characteristics in the Tool Assembly
Definition dialog box.
Specify Tool Compensation Information: Double click a tool referenced in the program
or resource list and specify the tool compensation information in the Compensation tab
page of the Tool Definition dialog box .
Create and Use Machining Patterns: Select Insert > Machining Feature > Machining
Pattern then select a pattern of holes to be machined.
Feature Based Programming: Select a feature using the Manufacturing view and create
operations based on this feature.
Define Macros on a Lathe Machining Operation: Select the Macros tab page when
creating or editing a lathe machining operation, then specify the transition paths of the
macros to be used in the operation.
Define Macros on an Axial Machining Operation: Select the Macros tab page when
creating or editing an axial machining operation, then specify the transition paths of the
macros to be used in the operation.
Manage the Status of Manufacturing Entities: Use the status lights to know whether or
not your operation is correctly defined.
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Edit the Tool of a Lathe Machining Operation
This task shows you how to edit the tool of a lathe machining operation.

A machining operation always has a tool assigned to it (default tool, for example). 

You can modify this tool in several ways:
edit its characteristics, thereby creating a new tool 
replace it by selecting another tool that is already used in the document
replace it by selecting another tool by means of a query.

1. Double click the operation in the program, then select the Tool tab page.

2. To create a new tool:

If you want to change tool type, select the icon
corresponding to the desired tool type.

In this case the corresponding tool
representation appears in the 2D viewer.

Double click the geometric parameter
that you want to modify in the 2D viewer,
then enter the desired value in the Edit
Parameters dialog box that appears.

Modify other parameters in the same
way.
The tool representation is updated to
take the new values into account.

Click More to expand the dialog box to
access all the tool's parameters.
Modify the values as desired.

Enter a name for the new tool.

3. To select a tool that is already used in the document:
Select the button opposite Name. 

Select the desired tool from the list of tools already used in your document.

The tool representation is displayed in the 2D viewer. It can be edited as described above. 



4. To select another tool by means of a query:
Click the Select a tool with query  icon opposite Name.
The Search Tool dialog box appears.

Use the Look in combo to specify where you want to search for the tool: 
in the current document, 
in a tool catalog
in an external tool database such as the Walter TDM (Tool Data Management) or CATIA
Version 4 Manufacturing database
in a Feeds and Speeds catalog.

If you want to change tool type, select the icon corresponding to the desired tool.

You can do a quick search in the Simple tab page by means of a character string on the tool
name. The tools meeting the simple search criteria are listed.

Select the desired tool from the list and click OK.  
The tool representation is displayed in the 2D viewer. It can be edited as described above. 
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You can search a tool using finer constraints by selecting the Advanced tab page. 

The example below shows the result of a search for a right hand tool with shank width of 15mm or more in
the catalog ToolsSampleLathe.

5. Click OK to confirm using this new tool in the operation.

 

 



Edit a Lathe Tool in the Resource List
This task shows you how to edit a lathe tool that is already used in your document.

1. To edit a tool in the resource list either double click it or right click it and select the
Definition contextual command.
The Tool Definition dialog
box is displayed allowing
you to edit the tool's
geometric, technological,
and compensation
characteristics.

2. If needed, enter a new
name for the tool.

You can also assign a
comment.

3. Click More to expand the
dialog box to access the
Geometry, Technology,
and Compensation tab
pages.



4. You can specify the tool
geometry in two ways:

double click a
parameter in the
large tool icon and
enter the desired 
value in the Edit
Parameter dialog
box that appears
or enter the
desired values in
the Geometry tab
page.

The icon representation
of the tool is updated with
these values.

5. Click the Technology tab
and enter the desired
values for the tool's
technological
parameters. 

6. If tool compensation is
required, click the
Compensation tab.

You can either edit an
existing compensation
site or add another site, if
other sites are proposed.



7. Right click the desired line to either edit or add tool compensation data.

The Compensation Definition dialog box appears.
8. Enter the desired values for the tool's compensation sites. 

See Specify Tool Compensation for more information.
9. Click OK to accept the modifications made to the tool.

A user representation (CATPart) can be assigned to the tool by the contextual
command in the Resource List.
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 Edit a Lathe Tool Assembly in the
Resource List

This task shows you how to edit a tool assembly that is already used in your document.

1. To edit a tool assembly in the resource list either double click it or right click it and select
the Definition contextual command.
The Tool
Assembly
Definition dialog
box is displayed
allowing you to
edit the tool
assembly's
geometric and
technological
characteristics.

2.  If needed, enter
a new name for
the tool
assembly.

You can also
assign a
comment.

3.  If needed, use
the spinner to
change the Tool
number.

4. Click More to
expand the
dialog box to
access the
Geometry and
Technology tab
pages.



5. You can specify
the tool
assembly
geometry in two
ways:

double
click a
parameter
in the
large tool
assembly
icon and
enter the
desired 
value in
the Edit
Parameter
dialog box
that
appears
or enter
the
desired
values in
the
Geometry
tab page.

6. Click the
Technology tab
and enter the
desired values
for the tool
assembly's
technological
parameters. 

7. Click OK to accept the modifications made to the tool assembly.
A user representation (CATPart) can be assigned to the tool assembly by the contextual
command in the Resource List.

 



  



Edit a Lathe Insert in the Resource List
This task shows you how to edit a lathe insert that is already used in your document.

1. To edit a lathe insert in the resource list either double click it or right click it and select
the Definition contextual command.
The Insert Definition
dialog box is displayed
allowing you to edit the
lathe insert's
characteristics.

2.  If needed, enter a new
name for the lathe insert.

You can also assign a
comment.

3.  If needed, use the
spinner to change the
Tool number.

4. Click More to expand the
dialog box to access the
Geometry and
Technology tab pages.



5. You can specify the lathe
insert geometry in two
ways:

double click a
parameter in the
large lathe insert
icon and enter the
desired  value in
the Edit Parameter
dialog box that
appears
or enter the desired
values in the
Geometry tab
page.

6. Click the Technology tab
and enter the desired
values for the lathe
insert's technological
parameters. 

7. Click the Feeds and
Speeds tab and enter the
desired values for the
lathe insert's feed and
speed parameters. 

8. Click OK to accept the modifications made to the lathe insert.
A user representation (CATPart) can be assigned to the lathe insert by the contextual
command in the Resource List.

 



 



Auxiliary Operations
The tasks for inserting auxiliary operations in the program are documented in the NC
Manufacturing Infrastructure User's Guide.

Insert Tool Change: Select the Tool Change icon then select the tool type to be
referenced in the tool change.
Insert Machining Axis System or Origin: Select the Machining Axis or Origin icon then
specify the characteristics of the machining axis system or origin.
Insert PP Instruction: Select the PP Instruction icon then enter the syntax of the PP
instruction.
Insert Copy Transformation Instruction: Select the reference operation then select the
Copy Transformation icon. You can then specify the number of copies and the
characteristics of the transformation.
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Verification, Simulation and Program
Output

The tasks for using capabilities such as tool path verification, material removal simulation, and
production of NC output data are documented in the NC Manufacturing Infrastructure User's
Guide.

Replay Tool Path: Select the Tool Path Replay icon then specify the display options for
an animated tool path display of the manufacturing program of machining operation.
Simulate Material Removal (P2 functionality): Select the desired icon in the Tool Path
Replay dialog box to run a material removal simulation either in Photo or Video mode.

Generate APT Source Code in Batch Mode: Select the Generate NC Code in Batch
Mode icon then select the manufacturing program to be processed and define the APT
source processing options.
Generate NC Code in Batch Mode: Select the Generate NC Code in Batch Mode icon
then select the manufacturing program to be processed and define the NC code
processing options.
Generate Clfile Code in Batch Mode: Select the Generate NC Code in Batch Mode icon
then select the manufacturing program to be processed and define the Clfile
processing options.
Generate a CGR File in Batch Mode (P2 functionality): Select the Generate NC Code
in Batch Mode icon then select the manufacturing program to be processed and define
the CGR file processing options.
Generate APT Source Code in Interactive Mode: Select the Generate NC Code
Interactively icon to generate APT source code for the current manufacturing program.
Generate Documentation: Select the Generate Documentation icon to produce shop
floor documentation in HTML format. 
 Import an APT Source into the Program: Select the APT Import contextual command
to insert an existing APT source into the current manufacturing program. 
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Part Operations, Programs and
Processes

The tasks for creating and managing Part Operations, Manufacturing Programs and Machining
Processes are documented in the NC Manufacturing Infrastructure User's Guide.

Create and Edit a Part Operation: Select the Part Operation icon then specify the
entities to be referenced by the part operation: machine tool, machining axis system,
tool change point, part set up, and so on.
Create and Edit a Manufacturing Program: Select the Manufacturing Program icon to
add a program to the current part operation then insert all necessary program entities:
machining operations, tool changes, PP instructions, and so on. 
Create a Machining Process (P2 Functionality): Select the Machining Process icon to
create a machining process, which will be stored in a CATProcess document and then
as a catalog component.
Apply a Machining Process (P2 Functionality): Select the Open Catalog icon to
access the machining process to be applied to selected geometry.
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Advanced Tasks
Tasks dealing with the following NC Manufacturing functionalities are described in the NC
Manufacturing Infrastructure User's Guide. 

Design Changes
Set Up and Part Positioning
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Workbench Description
This section contains the description of the menu commands and icon toolbars that are specific to the Lathe Machining
workbench.

Menu Bar
Toolbars

Specification Tree

 



Lathe Machining Menu Bar
The menu commands that are specific to Lathe Machining are described below.

Start File Edit View Insert Tools Windows Help

Tasks corresponding to general menu commands are described in the CATIA Version 5 Infrastructure
User's Guide.

Tasks corresponding to menu commands that are common to all NC Manufacturing products are described
in the NC Manufacturing Infrastructure User's Guide.

Insert Menu

Insert > Machining Operations

  Command... Description...

Roughing
Create a Longitudinal Roughing
Operation
Create a Parallel Contour Roughing
Operation
Create a Face Roughing Operation

Grooving Create Grooving Operation



Recessing Create Recessing Operation
Profile Finishing Create a Profile Finishing Operation
Groove Finishing Create a Groove Finishing Operation
Threading Create a Threading Operation
Sequential Machining Create a Sequential Machining

Operation
Axial Machining Operations Create Axial Machining Operations

Insert > Auxiliary Operations > Lathe Tool Change

 

Description...

Allows inserting lathe tool changes in the program.

 

 



Lathe Machining Toolbars
The Lathe Machining workbench includes a number of icon toolbars, some of which are common to all NC
workbenches and some of which are specific to Lathe Machining. The common toolbars are described in
the Toolbars section of the NC Manufacturing Infrastructure User's Guide.

The following toolbar is specific to the Lathe Machining workbench.

It contains commands to create and edit lathe machining operations as follows.
Create a Roughing operation. 
Basic tasks illustrate the following roughing modes:

Longitudinal
Face
Parallel Contours.

Create a Recessing operation.

Create a Grooving operation.

Create a Profile Finishing operation.

Create a Groove Finishing operation.

Create a Threading operation.

Create a Lathe Sequential operation.

Create Axial Machining Operations.

The following specific toolbar is accessed from the drop-down icon in the Auxiliary Operations toolbar.

It contains icons for creating and editing Tool Change operations as follows.

See External tool for more information about this resource

See Internal tool for more information about this resource

See External Groove tool for more information about this resource

See Frontal Groove tool for more information about this resource

See Internal Groove tool for more information about this resource

See External Thread tool for more information about this resource
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See Internal Thread tool for more information about this resource.

Please note that the icon representing a Tool Change operation in the tree looks like this: .
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Specification Tree
Here is an example of a Process Product Resources (PPR) specification tree for NC
Manufacturing products.

Process List is a plan that gives all the activities and machining operations required to
transform a part from a rough to a finished state.

Part Operation defines the manufacturing resources and the reference data.
Manufacturing Program is the list of all of the operations and tool changes performed.
The example above shows that:

Drilling.1 is complete and has not been computed
Drilling.2 is complete but has been computed (by means of a replay)
Drilling.3 does not have all of the necessary data (indicated by the exclamation
mark symbol)
Drilling.4 has been deactivated by the user (indicated by the brackets symbol)
Drilling.5 has been modified and needs to be recomputed (indicated by the
update symbol).



Product List gives all of the parts to machine as well as CATPart documents containing
complementary geometry. 
Resources List gives all of the resources such as machine or tools that can be used in the
program.
 

 



Customizing
Tasks for customizing your NC Manufacturing environment are described in the NC
Manufacturing Infrastructure User's Guide.

NC Manufacturing Settings
Build a Tools Catalog

Access External Tools Catalogs
PP Word Syntaxes
NC Documentation
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Reference Information
Reference information that is specific to the Lathe Machining product can be found in this
section.

Lathe Machining Operations
Cutter Compensation for Finish Operations

Changing the Output Point
Lathe Tool Assembly Considerations

Actual Stock Computation

Essential reference information on the following topics is provided in the NC Manufacturing
Infrastructure User's Guide.

Associativity
NC Manufacturing Resources

NC Macros
PP Tables and PP Word Syntaxes

Feeds and Speeds
APT Formats

CLfile Formats

http://biseldsy/jmndocr9/MfgEnglish/mfgug.doc/src/mfgugrf1000.htm
http://biseldsy/jmndocr9/MfgEnglish/mfgug.doc/src/mfgugrf0700.htm
http://biseldsy/jmndocr9/MfgEnglish/mfgug.doc/src/mfgugrf0400.htm
http://biseldsy/jmndocr9/MfgEnglish/mfgug.doc/src/mfgugrf0800.htm
http://biseldsy/jmndocr9/MfgEnglish/mfgug.doc/src/mfgugrf0500.htm
http://biseldsy/jmndocr9/MfgEnglish/mfgug.doc/src/mfgugrf0600.htm
http://biseldsy/jmndocr9/MfgEnglish/mfgug.doc/src/mfgugrf0900.htm


Lathe Machining Operations
The information in this section will help you create and manage the machining operations supported by
the Lathe Machining product. These operations are:

Roughing
Recessing
Grooving
Profile Finishing
Groove Finishing
Threading
Sequential Machining:

Go motion
Go InDirv motion
Go Delta motion
Follow motion.

Roughing Operations
The Roughing operation allow you to specify:

Longitudinal, Face and Parallel Contour roughing modes
external, internal or frontal machining according to the type of area to machine
relimitation of the area to machine
various approach and retract path types
various lead-in and lift-off options with specific feedrates
recess machining
various contouring options with specific feedrates.

External and Internal turning and grooving tools may be used.

Geometry for Roughing

Part and Stock profiles are required.

The End Limit option allows you to specify a point, line or curve to relimit or extrapolate the selected
part profile. The position of the end of machining is defined with respect to this element by one of the
following settings: None / In / On / Out.

Orientation for Roughing

The following Orientations are proposed: Internal, External and Frontal (for Face and Parallel Contour
Roughing only).

The selected Orientation defines the type of geometric relimitation to be done between the stock and
part geometry in order to determine the area to machine. Selected part and stock profiles do not need
to be joined (see the following figures).

External Roughing



Internal Roughing

Frontal Roughing

Frontal machining is proposed for face roughing. In that case, the minimum and maximum diameters
of the area to machine are determined by the stock profile dimensions.

For example, in the following figure the area to machine is relimited by the spindle axis because the
stock profile is also relimited by the spindle axis.



Location and Limits for Roughing

The following machining Locations are proposed:
Front, the part is machined toward the head stock
Back, the part is machined from the head stock.

Orientation and Location settings determine the way the program closes the area to machine using
radial, axial, axial-radial or radial-axial relimitation.

The following options allow you to restrict the area to machine that is pre-defined by the stock and
part. You may want to restrict this area due to the physical characteristics of the tool and the type of
machining to be done.
Minimum Machining Radius



Maximum Machining Radius (for internal machining)

Note that Max Boring Depth is defined on the tool.
Axial Limit for Chuck Jaws (for external or frontal machining): Offset defined from the machining axis
system.

Part and Stock Thicknesses for Roughing



Clearance on stock, which is defined perpendicular to the stock profile.
Thickness on part, which is defined perpendicular to the part profile.
Axial offset on part.
Radial offset on part.
End limit clearance: distance with respect to the end element (only if end element is a line or a
curve, and when In or Out  is set for end element positioning).

Radial and axial offsets can be positive or negative with any absolute value. The thickness applied to
the part profile is the resulting value of the normal thickness and the two offsets.

  Thickness on part 

In this example, a "virtual nose radius" is obtained by adding the specified thickness value to the real
nose radius. 

Axial offset on part

A "virtual part profile" is obtained by translating the part profile the specified offset value along the
spindle axis direction.



Radial offset on part

A "virtual part profile" is obtained by translating the part profile the specified offset value perpendicular
to the spindle axis direction.

Machining Strategy Parameters for Roughing

Path Definition for Roughing

Machining tolerance



Max Depth of Cut
This option is used to specify the maximum distance between passes.
It is replaced by Radial Depth of Cut and Axial Depth of Cut for Parallel Contour Roughing.
Leading and Trailing Safety Angles
The insert geometry is taken into account to avoid collision by reducing the maximum slope on
which the tool can machine. The Leading Safety Angle and Trailing Safety Angle allow you to
further reduce this slope.
Note that Trailing Angle can be used only when Recess Machining is set. 
Leading and trailing angles can also be defined on the tool to define the maximum slope on
which the tool can machine. In this case, the angles that reduce the slope the most will be taken
into account.
Part Contouring
You can specify a contouring type for longitudinal and face roughing in order to clear the part
profile by means of the following settings:

No: no contouring
Each path: profile following at each roughing pass
Last path only: profile following at last roughing pass only.

Under Spindle Axis Machining
For Face Roughing and Parallel Contour Roughing with Frontal machining, this option allows
you to request machining under the spindle axis.
Machining Direction (only for Parallel Contour and Face Roughing with Frontal machining)
You can specify the machining direction with respect to the spindle axis by means of the
To/From Spindle Axis choice.
Recess Machining (if Contouring Type is Each Pass or Last Path Only)
If you require recess machining, activate this checkbox.
When recess machining is active in Parallel Contour Roughing, the toolpath may not be
collision free for some combinations of Axial and Radial Cut Depth.

The following options are proposed for recess machining:
Plunge Distance and Plunge Angle (for longitudinal and face roughing)
Define the plunge vector before each new pass with respect to the cutting direction.



Example of recess with longitudinal external roughing. Note that Trailing angle is defined on the tool. 

In the figure above the tool motion is as follows:
approach in RAPID
lead-in at the first recess pass and plunge approach for other passes
plunge at plunge feedrate
machine at machining feedrate
contouring at contouring feedrate
lift-off at last recess pass at lift-off feedrate.

Lead-in, Lift-off and Attack for Roughing

These options allow penetration into the workpiece at a reduced feedrate in order to prevent tool
damage. Once the attack distance has been run through, the tool moves at machining feedrate.

Lead-in Distance
Defined with respect to the cutting direction and the stock profile with a stock clearance. The
tool is in rapid mode before this distance.
Lead-in Angle.
If no lead-in angle is requested, lead-in path is parallel to the machining direction.
For Longitudinal and Face Roughing the Lead-in Angle can be applied as follows:

no angle applied to lead-in path
lead-in angle applied to each path
lead-in angle applied to last path only.

Attack Distance
Defined with respect to the cutting direction and the stock profile with a stock clearance.



Lift-off Distance and Lift-off Angle
Define the lift-off vector at the end of each new pass with respect to the cutting direction.

For Longitudinal or Face roughing, lift-off occurs:
at the end of each pass when Contouring Type is set to None or Last Path Only.
At the end of the last pass of the operation when the contouring type is set to Each Path. This
prevents the tool from damaging the part when returning to the end point in RAPID mode.
at the end of each pass that ends on the stock profile.

For Parallel Contour Roughing, lift-off occurs when the end of the pass has already been machined by
a previous pass.



Feeds and Speeds for Roughing

Speed unit can be set to:
Angular: spindle speed in revolutions per minute
Linear: constant cutting speed in units per minute

then you can give a Machining Speed value.
Machining Feedrate in units per revolution
Lead-in Feedrate which is applied during the lead-in and attack distance.
Lift-off Feedrate
Contouring Feedrate (if contouring type is Each Path or Last Path Only).
Plunge Feedrate (for longitudinal and face roughing)
Dwell setting indicates whether the tool dwell at the end of each path is to be set in seconds or
a number of spindle revolutions.

Tool Compensation for Roughing  

You can select a tool compensation number corresponding to the desired tool output point. Note
that the usable compensation numbers are defined on the tool assembly linked to the machining
operation. If you do not select a tool compensation number, the output point corresponding to type P9
will be used by default.

Approach and Retract Macros for Roughing

The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial. The
selected type (approach or retract) defines the tool motion before or after machining: the tool moves in
rapid motion during the approach or retract.

  

Recessing Operation
The Recessing operation allows you to machine a recess by means of a One Way, Zig Zag or Parallel
Contour tool motion. 



You can specify:
external, internal, frontal or inclined machining according to the type of area to machine
various approach and retract path types
various lead-in and lift-off options with specific feedrates
part contouring
tool output point change.

This operation supports all lathe tool types and inserts except threading tools.

Geometry for Recessing

Part and Stock profiles are required.

Orientation for Recessing

The following Orientations are proposed: internal, external, frontal and inclined.

The selected Orientation defines the type of geometric relimitation to be done between the stock and
part geometry in order to determine the area to machine. For an inclined orientation you must specify
the Angle of Incline.

Part and Stock Thicknesses for Recessing

Clearance on stock, which is defined perpendicular to the stock profile
Thickness on part, which is defined perpendicular to the part profile.
Axial offset on part
Radial offset on part.

Radial and axial offsets can be positive or negative with any absolute value. The thickness applied to
the part profile is the resulting value of the normal thickness and the two offsets.



Machining Strategy Parameters for Recessing

Path Definition for Recessing

Recessing Mode: One Way, Zig Zag or Parallel Contour
Max Depth of Cut
This option is used to specify the maximum distance between passes.
Axial and Radial Depth of Cut
These options are used to specify the maximum axial and radial distances between passes for
Parallel Contour mode.
Machining tolerance
Machining Direction
For Zig Zag tool motion, you must specify a first cutting direction as follows:

To or From Head Stock for Internal and External machining
To or From Spindle for Frontal machining
To Right or Left of Recess for Inclined machining

When a part profile has multiple recesses (that is, a non-convex profile along the cutting
direction), only the first recess along the specified direction is machined.
Leading and Trailing Safety Angles for One way and Parallel Contour modes
The insert geometry is taken into account to avoid collision by reducing the maximum slope on
which the tool can machine. The Leading and Trailing Safety Angles allow you to further reduce
this slope.
Note that leading and trailing angles can also be defined on the tool to define the maximum
slope on which the tool can machine. In this case, the angles that reduce the slope the most will
be taken into account.
Gouging Safety Angle (for Zig Zag mode only)
Angles of the insert are taken into account to avoid collision by reducing the maximum slope on
which the tool can machine. The Gouging Safety Angle allows you to further reduce this slope.
Note that a gouging angle can also be defined on the tool to define the maximum slope on
which the tool can machine. In this case, the angle that reduces the slope the most will be taken
into account.
Under Spindle Axis Machining
For Frontal or Inclined machining, this option allows you to request machining under the spindle
axis.
Part Contouring
You can specify if contouring is required by means of the proposed checkbox.
The part profile is followed at the end of recessing. This is done by machining down the sides of
the recess in order to clear the profile.



Lead-in, Lift-off and Attack for  Recessing

Lead-in Distance
Defined with respect to the cutting direction and the stock profile with a stock clearance. The
tool is in rapid mode before this distance.
Attack Distance
Defined with respect to the cutting direction and the stock profile with a stock clearance.
Angle and Distance before Plunge
Define the plunge vector before each new pass with respect to the cutting direction.
Lift-off Distance and Lift-off Angle
Define the lift-off vector at the end of the last pass with respect to the cutting direction.



Example of one-way recessing. Note that Trailing angle is defined on the tool.  

In the figure above the tool motion is as follows:
approach in RAPID
lead-in at the first recess pass and plunge approach for other passes
plunge at plunge feedrate
machine at machining feedrate
contouring at contouring feedrate
lift-off at last recess pass at lift-off feedrate.

Feeds and Speeds for Recessing

Speed unit can be set to:
Angular: spindle speed in revolutions per minute
Linear: constant cutting speed in units per minute

then you can give a Machining Speed value.
Machining Feedrate in units per revolution
Lead-in Feedrate, which is applied during the lead-in and attack distance.
Lift-off Feedrate
Contouring Feedrate
Plunge Feedrate
Dwell setting indicates whether the tool dwell at the end of each path is to be set in seconds or
a number of spindle revolutions.



Tool Compensation for Recessing

You can select a tool compensation number corresponding to the desired tool output point. Note
that the usable compensation numbers are defined on the tool assembly linked to the machining
operation. If you do not select a tool compensation number, the output point corresponding to type P9
will be used by default.

Note that the change of output point is managed automatically if you set the Change Output Point
option.
If the output point is consistent with the flank of the recess to be machined, the output point is changed
when the other flank of the recess is machined.
At the end of the operation, the output point is the same as it was at the start of the operation. See
Changing the Output Point for more information.

Approach and Retract Macros for Recessing

The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial. The
selected type (approach or retract) defines the tool motion before or after machining: the tool moves in
rapid motion during the approach or retract. 

Grooving Operation
The Grooving operation allows you to machine a groove by a series of plunging cuts. You can specify:

external, internal, frontal or inclined machining according to the type of area to machine
various approach and retract path types
various lead-in and lift-off options with specific feedrates
various plunge locations
tool output point change.

Grooving tools should be used.

Geometry for Grooving

Part and Stock profiles are required.

Orientation for Grooving 

The following Orientations are proposed: internal, external, frontal and inclined. The selected
Orientation defines the type of geometric relimitation to be done between the stock and part geometry
in order to determine the area to machine. For an inclined orientation you must specify the Angle of
Incline.

Part and Stock Thicknesses for Grooving

Clearance on stock, which is defined perpendicular to the stock profile
Thickness on part, which is defined perpendicular to the part profile.
Axial offset on part
Radial offset on part.

Radial and axial offsets can be positive or negative with any absolute value. The thickness applied to



the part profile is the resulting value of the normal thickness and the two offsets.

Machining Strategy Parameters for Grooving

Path Definition for Grooving

Max Depth of Cut
This option is used to specify the maximum distance between plunges.
First Plunge
You must specify a first plunge position according to the groove orientation by means of the
following choice: Left/Down - Center - Right/Up - Automatic. 
Automatic is only available for frontal machining. In this case, the position of the first plunge is
deduced on the tool by reading the tool's minimum and maximum cutting diameters.
Next Plunges (if First Plunge is set to Center).
You can specify the position of the plunges that follow the first plunge with respect to:

the spindle axis by means of the To or From Spindle for frontal machining
the head stock by means of the To or From Head Stock for internal or external machining
the groove by means of Left or Right of Groove for Inclined machining.

Part Contouring
You can specify if contouring is required by means of the proposed checkbox.
The part profile is followed at the end of grooving. This is done by machining down the sides of
the groove in order to clear the profile.
Grooving by Level mode
This option allows you to machine the groove in one or more level. 
Multiple-levels mode is particularly useful when the groove is too deep to machine in one level.
In this case Maximum grooving depth defines the maximum depth of each level. If it is greater
than the Maximum Depth of Cut defined on the tool, the value on the tool is taken into account.
Under Spindle Axis Machining
When grooving in frontal mode, this option allows you to request machining under the spindle
axis.
Chip Break
You can specify if chip clearing is to be done during machining by setting the check box. In this
case you must specify Plunge, Retract and Clear distances.
Gouging Safety Angle
Angles of the grooving insert are taken into account to avoid collision by reducing the maximum
slope on which the tool can machine. The Gouging Safety Angle allows you to further reduce
this slope.
Note that a gouging angle can also be defined on the tool to define the maximum slope on
which the tool can machine. In this case, the angle that reduces the slope the most will be taken
into account.
Machining Tolerance.

Lead-in, Lift-off and Attack for Grooving

Lead-in Distance
Defined with respect to the cutting direction and the stock profile with a stock clearance. The
tool is in rapid mode before this distance.
Attack Distance
Defined with respect to the cutting direction and the stock profile with a stock clearance.



These options allow penetration into the workpiece at a reduced feedrate in order to
prevent tool damage. Once the attack distance has been run through, the tool moves at
machining feedrate.

When tool motion between two passes is in contact with the part profile, in order to avoid
collisions the corresponding feed is the lift-off feedrate and not rapid feedrate.
Lift-off Distance and Lift-off Angle
Define the lift-off vector at the end of each new pass with respect to the cutting direction.

Feeds and Speeds for Grooving

Speed unit can be set to:
Angular: spindle speed in revolutions per minute
Linear: constant cutting speed in units per minute

then you can give a Machining Speed value.
Contouring Feedrate
Lead-in Feedrate, which is applied during lead-in and attack distances.
Lift-off Feedrate
First Plunge Feedrate and Next Plunges Feedrate
Different feedrates can be assigned to the first plunge and the following plunges.
Dwell setting indicates whether the tool dwell at the end of a path or a plunge is to be set in
seconds or a number of spindle revolutions.

Tool Compensation for Grooving 

You can select a tool compensation number corresponding to the desired tool output point. Note
that the usable compensation numbers are defined on the tool assembly linked to the machining
operation. If you do not select a tool compensation number, the output point corresponding to type P9
will be used by default. 

Note that the change of output point is managed automatically if you set the Change Output Point
option.
If the output point is consistent with the flank of the groove to be machined, the output point is changed
when the other flank of the groove is machined.
At the end of the operation, the output point is the same as it was at the start of the operation. See
Changing the Output Point for more information.

Approach and Retract Macros for Grooving

The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial. The
selected type (approach or retract) defines the tool motion before or after machining: the tool moves in
rapid motion during the approach or retract. 

Profile Finishing Operation
The Profile Finishing operation allows you to finish a part profile. You can specify:

the type of machining according to the profile of the area to machine (external, internal or
frontal)



relimitation of the profile by start and end elements
various approach and retract path types
linear and circular lead-in and lift-off options with specific feedrates
recess machining
various corner processing options
cutter compensation.

External and Internal tools can be used.

Geometry for Profile Finishing 

A Part profile is required.
Start Limit: None / In / On / Out
This option allows you to specify a point, line or curve as the start element of the part profile.
The position of the start of machining is also defined with respect to this element.
In / On / Out: allows you to specify the Go-Go type positioning of the tool with respect to the
start element. The On option is always used for a point type start element.
If needed, the profile may be extrapolated to the start element.
End Limit: None / In / On / Out
This option allows you to specify a point, line or curve as the end element of the part profile.
The position of the end of machining is also defined with respect to this element. 
In / On / Out: allows you to specify the Go-Go type positioning of the tool with respect to the
end element. The On option is always used for a point type end element.

If needed, the profile may be extrapolated to the end element.

Use of start and end elements for profile finishing. Profile is machined from start element. Profile is
extrapolated up to end element. Direct approach and radial-axial retract.

Orientation and Location for Profile Finishing



Orientation: Internal / External / Frontal
This option allows you to specify the type of machining according to the location of the area to
machine on the part.
Location: 

Front, the profile is machined toward the head stock
Back, the profile is machined from the head stock.

Corner Processing for Profile Finishing 

The following options allow you to define how corners of the profile are to be machined:
None: no corners are to be machined along the profile
Chamfer: only 90 degree corners of the profile are chamfered
Rounded: all corners of the profile are rounded.

Corner processing options are also available to define how the entry and exit corners are to be
machined. Entry and exit corners are defined by either a chamfer length, or a corner radius and corner
angle.

Part Thicknesses for Profile Finishing

Thickness on part, which is defined perpendicular to the part profile.



Axial offset on part.
Radial offset on part.
Start limit clearance: distance with respect to the start element (only if start element is a line or
a curve, and when In or Out is set for start element positioning).
End limit clearance: distance with respect to the end element (only if end element is a line or a
curve, and when In or Out is set for end element positioning).

Radial and axial offsets can be positive or negative with any absolute value. The thickness applied to
the part profile is the resulting value of the normal thickness and the two offsets.

In addition to these global thickness and offsets, local thicknesses and offsets can be applied to
segments, curves and arcs of the part profile.

Machining Strategy Parameters for Profile Finishing

Path Definition for Profile Finishing

Machining Direction: To or  From Spindle
This option is only available for frontal machining for specifying the machining direction with
respect to the spindle axis.

If start and end elements are defined that are in conflict with the machining direction, then
these elements will be reversed automatically.
Contouring for Outside Corners: Angular / Circular
Allows you to define whether angular or circular contouring is to be applied to corners of the
profile (only if corner processing is set to Rounded or Chamfer).

Under Spindle Axis Machining
When finishing in frontal mode, this option allows you to request machining under the spindle
axis.



Recess Machining
When this option is set, the trailing safety angle option is available.
Leading and Trailing Safety Angles
The insert geometry is taken into account to avoid collision by reducing the maximum slope on
which the tool can machine. The Leading Safety Angle and Trailing Safety Angle allow you to
further reduce this slope.
Note that leading and trailing angles can also be defined on the tool to define the maximum
slope on which the tool can machine. In this case, the angles that reduce the slope the most will
be taken into account.
Machining Tolerance for following the profile.

Lead-in and Lift-off for Profile Finishing

Lead-in type: Linear / Circular  
Defines the type of lead-in onto the profile at lead-in feedrate

Linear: lead-in up to the point where profile machining starts is defined by means of the
lead-in distance and lead-in angle options.
Circular: lead-in is circular and tangent to the point where profile machining starts. It is
defined by means of the lead-in radius and lead-in angle options.

Linear lead-in and circular lift-off (profile finishing)

Lift-off type: Linear / Circular.
 Defines the type of lift-off from the profile at lift-off feedrate

Linear: lift-off from the point where profile machining ends is defined by means of the
lift-off distance and lift-off angle options.
Circular: lift-off is circular and tangent from the point where profile machining ends. It is
defined by means of the lift-off radius and lift-off angle options.

In the example below, the round tool is tangent In start element plus clearance at start of profiling.
Round tool is tangent Out end element plus clearance at end of profiling.



Feeds and Speeds for Profile Finishing

Speed unit can be set to:
Angular: spindle speed in revolutions per minute
Linear: constant cutting speed in units per minute

then you can give a Machining Speed value.
Machining Feedrate in units per revolution
Chamfering Feedrate for machining chamfers or corners (in units per revolution)
Lift-off Feedrate in units per revolution
Lead-in Feedrate in units per revolution.

In addition to these global feedrates, local feedrates can be applied to segments, curves and arcs of
the part profile.

Tool Compensation for Profile Finishing 

You can select a tool compensation number corresponding to the desired tool output point. Note
that the usable compensation numbers are defined on the tool assembly linked to the machining
operation. If you do not select a tool compensation number, the output point corresponding to type P9
will be used by default. 

CUTCOM (Cutter Compensation): None / On / Reverse.
If this option is set to On or Reverse, the NC output will include CUTCOM instructions in approach and
retract paths for cutter compensation.

On: CUTCOM/RIGHT instruction generated if tool is to the right of the toolpath and
CUTCOM/LEFT if tool is to the left of the toolpath.
Reverse: CUTCOM/RIGHT instruction generated if tool is to the left of the toolpath and
CUTCOM/LEFT if tool is to the right of the toolpath.

See Cutter Compensation with Finish Operations for more information.



Approach and Retract Macros  for Profile Finishing 

The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial. The
selected type (approach or retract) defines the tool motion before or after machining: the tool moves in
rapid motion during the approach or retract. 

Groove Finishing Operation
The Groove Finishing operation allows you to finish a groove by means of downward profile following.
You can specify:

the type of machining according to the groove profile to be machined (external, internal, frontal
or inclined)
relimitation of the profile by start and end elements
various approach and retract path types
linear and circular lead-in and lift-off options with specific feedrates
various corner processing options with specific feedrates
local feedrates for individual elements of the machined profile
tool output point change
cutter compensation.

Grooving tools or round inserts should be used.

Geometry

The Part profile is required.
Start Limit: None / In / On / Out
This option allows you to specify a point, line or curve as the start element of the groove finish
profile. The position of the start of machining is also defined with respect to this element.

In / On / Out: allows you to specify the Go-Go type positioning of the tool with
respect to the start element. The On option is always used for a point type start
element.

If needed, the groove finish profile may be extrapolated to the start element.
End Limit: None / In / On / Out
This option allows you to specify a point, line or curve as the end element of the groove finish
profile. The position of the end of machining is also defined with respect to this element.

In / On / Out: allows you to specify the Go-Go type positioning of the tool with
respect to the end element. The On option is always used for a point type start
element.

If needed, the groove finish profile may be extrapolated to the end element.

Orientation for Groove Finishing

Orientation: Internal / External / Frontal / Inclined
This option allows you to define the orientation of the groove to be machined.

For an inclined orientation you must specify the Angle of Incline.

Corner Processing for Groove Finishing 



The following options allow you to define how corners of the profile are to be machined:
Follow profile: no corners are to be machined along the profile
Chamfer: only 90 degree corners of the profile are chamfered
Rounded: all corners of the profile are rounded.

Corner processing is proposed for Entry, Exit and Other corners.
Chamfer Length if Other corner processing mode is Chamfer.
Corner Radius if Other corner processing mode is Rounded.
Entry Corner Chamfer Length on first flank of groove when Entry corner processing mode is
Chamfer
Entry Corner Radius on first flank of groove when Entry corner processing mode is Corner
Entry Corner Angle on first flank of groove when Entry corner processing mode is Corner
Exit Corner Chamfer Length on last flank of groove when Exit corner processing mode is
Chamfer
Exit Corner Radius on last flank of groove when Exit corner processing mode is Corner
Exit Corner Angle on last flank of groove when Exit corner processing mode is Corner.

Part Thicknesses for Groove Finishing

Thickness on Part, which is defined perpendicular to the part profile.
Axial Offset on Part
Radial Offset on Part.
Start Limit Clearance: distance with respect to the start element (only if start element is a line
or a curve, and when In or Out is set for start element positioning).
End Limit Clearance: distance with respect to the end element (only if end element is a line or
a curve, and when In or Out is set for end element positioning).

Radial and axial offsets can be positive or negative with any absolute value. The thickness applied to
the part profile is the resulting value of the normal thickness and the two offsets. In addition to these
global thickness and offsets, local thicknesses and offsets can be applied to segments, curves and
arcs of the part profile.

Machining Strategy Parameters for Groove Finishing

Path Definition for Groove Finishing

Machining Direction
You can specify the machining direction by means of:

To or From Head for Internal and External machining
To or  From Spindle for Frontal machining
To Right or Left of Groove for Inclined machining

If start and end elements are defined that are in conflict with the machining direction, then
these elements will be reversed automatically.
Clearance: this value defines the clearance to be applied to the next flank after the first
machined flank. The bottom of the groove will be machined up to the position defined by this
clearance value.
Tool Overlap Distance on Groove Bottom.



Under Spindle Axis Machining
When finishing in frontal mode, this option allows you to request machining under the spindle
axis.
Contouring for Outside Corners: Angular / Circular
Allows you to define whether an angle or circle contouring mode is to be applied to corners of
the groove profile (only if corner processing is set to None or Chamfer).
Machining Tolerance for following the groove finish profile.

Lead-in for Groove Finishing

First Flank Lead-in: Linear / Circular
Defines the type of lead-in at lead-in feedrate on the first flank of the groove.

Linear: lead-in up to the point where first flank machining starts is defined by means
of the first lead-in distance and first lead-in angle options.
Circular: lead-in is circular and tangent to the point where first flank machining
starts. It is defined by means of the first lead-in radius and first lead-in angle
options.

The example below shows Linear lead-in and Circular lift-off for groove finishing.



Last Flank Lead-in: Linear / Circular  
Defines the type of lead-in at lead-in feedrate on the last flank of the groove.

  Linear: lead-in up to the point where last flank machining starts is defined by means of
the last lead-in distance and last lead-in angle options. 
Circular: lead-in is circular and tangent to the point where last flank machining starts. It is
defined by means of the last lead-in radius and last lead-in angle options.

Other Flank Lead-in: Linear / Circular
For a groove that has multiple recesses, this option defines the type of lead-in required to
machine flanks other than the first and last flanks.

Other Lead-in Distance on other flanks of the groove when other flank lead-in type
is Linear
Other Lead-in Angle on other flanks of the groove when other flank lead-in type is
Linear or Circular
Other Lead-in Radius on other flanks of the groove when other flank lead-in type is
Circular.

Lift-off for Groove Finishing

Lift-off Type: Linear / Circular
Defines the type of lift-off from the groove at lift-off feedrate.

Lift-off Distance when lift-off type is Linear.
Lift-off Angle when lift-off type is Linear or Circular.
Lift-off Radius when lift-off type is Circular.

Feeds and Speeds for Groove Finishing

Speed unit can be set to:
Angular: spindle speed in revolutions per minute
Linear: constant cutting speed in units per minute

then you can give a Machining Speed value.
Machining Feedrate in units per revolution
Chamfering Feedrate for machining chamfers or corners (in units per revolution)
Lift-off Feedrate in units per revolution
Lead-in Feedrate in units per revolution.

In addition to these global feedrates, local feedrates can be applied to segments, curves and arcs of
the part profile.

Tool Compensation for Groove Finishing 

You can select a tool compensation number corresponding to the desired tool output point. Note
that the usable compensation numbers are defined on the tool assembly linked to the machining
operation. If you do not select a tool compensation number, the output point corresponding to type P9
will be used by default. 

CUTCOM (Cutter Compensation): None / On / Reverse
If this option is set to On or Reverse, the NC output will include CUTCOM instructions in approach and



retract paths for cutter compensation.
On: CUTCOM/RIGHT instruction generated if tool is to the right of the toolpath and
CUTCOM/LEFT if tool is to the left of the toolpath.
Reverse: CUTCOM/RIGHT instruction generated if tool is to the left of the toolpath and
CUTCOM/LEFT if tool is to the right of the toolpath.

See Cutter Compensation with Finish Operations for more information. 

Note that the change of output point is managed automatically if you have set the Change Output
Point option. If the output point is consistent with the flank of the groove to be machined, the output
point is changed when the other flank of the groove is machined. At the end of the operation, the
output point is the same as it was at the start of the operation. See Changing the Output Point for more
information.

Approach and Retract Macros for Groove Finishing

The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial. The
selected type (approach or retract) defines the tool motion before or after machining: the tool moves in
rapid motion during the approach or retract. 

Threading
The Threading operation allows you to specify:

the type of machining according to the required thread (external or internal)
relimitation of the profile by start and end elements
thread machining options
various approach and retract types
PP Word syntaxes.

 External and Internal threading tools can be used.

Geometry for Threading

A Part profile is required.
End Limit: None / In / On / Out
This option allows you to specify a point, line or curve as the end element of the profile to be
machined. The position of the end of machining is also defined with respect to this element.
In / On / Out: allows you to specify the Go-Go type positioning of the tool with respect to the
end element. The On option is always used for a point type end element. 
If needed, the profile may be extrapolated to the end element.
End Limit Clearance: distance with respect to the end element (only if end element is a line or
a curve, and when In or Out is set for end element positioning).
Start Limit: None / In / On / Out
This option allows you to specify a point, line or curve as the start element of the profile to be
machined. The position of the start of machining is also defined with respect to this element. 
In / On / Out: allows you to specify the Go-Go type positioning of the tool with respect to the
start element. The On option is always used for a point type end element. 
If needed, the profile may be extrapolated to the start element.



Start Limit Clearance: distance with respect to the start element (only if start element is a line
or a curve, and when In or Out  is set for start element positioning).

Orientation and Location for Threading

Orientation: Internal / External
This option allows you to specify the type of machining according to the location of the area to
machine on the part.
Location: Front / Back

Front, the profile is machined toward the head stock
Back, the profile is machined from the head stock.

Threads

Thread profile: ISO / Trapezoidal / UNC / Gas / Other
Other allows defining a specific thread profile.
Thread unit: Pitch / Threads per Inch
You must specify the thread type when the Thread profile is Other. Thread is automatically set
to Pitch for the ISO and Trapezoidal types and set to Threads per Inch for UNC and Gas.
Nominal diameter
This value must be given when Thread type is internal and Thread profile is Other.
Thread length
This value must be given when the Start or End relimiting element is set to Profile End.
Thread pitch
This value must be given when the Thread type is set to Pitch or the Thread profile is ISO or
Trapezoidal.
Threads/inch
This value must be given when the Thread type is set to Thread per inch or when the Thread
profile is UNC or Gas.
Thread depth
This value must be given when the Thread profile is Other.
Number of threads
When greater than 1, this value allows you to specify whether a multi-start thread is to be
machined.

Machining Strategy Parameters for Threading

Machining Options for Threading

Threading type. You must choose the desired threading type:
Constant depth of cut
Constant section of cut

Maximum Depth of cut when Threading type is set to Constant depth of cut
Number of passes when Threading type is set to Constant section of cut.
When the number of passes is defined, the Section of cut value is automatically set.
Machining spindle speed



Thread Penetration type:
Straight
Oblique
Alternate.

Penetration angle must be specified for Oblique or Alternate entry types.

Path Computation options for Threading

Clearance on crest diameter
Lead-in Distance
Lift-off Distance and Lift-off Angle.

First and Last Passes options for Threading

Manage penetration on first passes by means of the First passes check box. This option is
available when Threading type is set to Constant section of cut. When activated, you must
specify values for:

Number of first passes
First section rate.

When these two values are specified, the Section of cut for first passes value is
automatically set.
Manage penetration on the last passes by means of the Last passes check box. When
activated, you must specify:

Number of last passes
Depth of cut for last passes.

Manage the spring passes by means of the Spring passes check box. When activated, you
must specify a Number of spring passes.

CYCLE or GOTO Output Syntaxes

If you want to generate CYCLE statements, you must select the Output CYCLE syntax checkbox in
the Options tab and set the Syntax Used option to Yes in the NC Output generation dialog box.
Otherwise, GOTO statements will be generated. 

The parameters available for PP word syntaxes for this type of operation are described in the
NC_LATHE_THREADING section of the Manufacturing Infrastructure User's Guide.

Tool Compensation for Threading 

You can select a tool compensation number corresponding to the desired tool output point. Note
that the usable compensation numbers are defined on the tool assembly linked to the machining
operation. If you do not select a tool compensation number, the output point corresponding to type P9
will be used by default. 

Note that the change of output point is managed automatically if you set the Change Output Point
option for Trapezoidal or Other Thread profile.

http://biseldsy/jmndocr9/MfgEnglish/mfgug.doc/src/mfgugbt0403.htm#SyntaxUsed
http://biseldsy/jmndocr9/MfgEnglish/mfgug.doc/src/mfgugrf0800.htm#NC_LATHE_THREADING


Approach and Retract Macros for Threading 

The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial. The
selected type (approach or retract) defines the tool motion before or after machining: the tool moves in
rapid motion during the approach or retract. 

Sequential Machining
You can create a sequence of basic Go, Go InDirv, Go Delta, and Follow tool motions in a single
Sequential Machining operation. PP words can be inserted in the sequence of tool motions.

When you select the Tool motion management icon a panel is displayed listing any previously created
tool motions and PP words. You can create or edit tool motions and PP words.

If there are no previously created tool motions listed in the panel, you are prompted to create a start
position. This start position must be a Go motion that uses either a point or two different check
elements.

When defining a tool motion, the corresponding new tool position is displayed according to all the
options that were selected for creating this motion.

Geometry Selection

You can select point / line / curve / edge elements as follows:

Point / line and curve elements must belong to the plane that is defined by the machine spindle axis
and radial axis. 

Edge elements must be coaxial with the machine spindle axis. 

Go Motion

In Go motion, the program positions the tool with respect to one or two check elements. 

When only one check element is selected, the tool is projected onto the check element.

When two check elements are selected, the tool is positioned with respect to the two check elements.

The tool is positioned with respect to each check element depending on the TO-ON-PAST mode. 

TO: the tool nose is positioned tangent to the near side of the selected element with a possible
thickness or offset.
ON: the tool nose is positioned on the selected element, with a possible axial or radial offset (normal
thickness, collision avoidance and safety angles are not applicable).
PAST: the tool nose is positioned tangent to the far side of the selected element with a possible
thickness or offset.

The first check element can be point, line, curve, or edge type elements.
If it is a point, no second check element can be selected. Otherwise, the second check element can be
line, curve or edge type elements. 

The following options are available when defining a Go motion:



Control over geometric extrapolation of each check curve.
Normal thickness, and axial and radial offset with respect to each check element.
Feedrate and spindle speed.
Collision avoidance for each check element when the tool is positioned in TO or PAST mode.
Left and right safety angles when collision avoidance is used.
Machining tolerance
Tool compensation
Guiding Point, if a square or grooving insert is used.

Note that the positioning mode (TO, ON, PAST), clearance, thickness and offset are not applicable
when the tool is positioned on a point. 

Go InDirv Motion

In Go InDirv (Go in Direction Vector) motion, the tool moves in a given direction up to the selected
check curve.
The tool is positioned with respect to the selected element depending on the TO-ON-PAST mode. 

TO: the tool nose is positioned tangent to the near side of the selected element with a possible
thickness or offset.
ON: the tool nose is positioned on the selected element, with a possible axial or radial offset (normal
thickness, collision avoidance and safety angles are not applicable).
PAST: the tool nose is positioned tangent to the far side of the selected element with a possible
thickness or offset.

The selected check curve can be edge, line and curve type elements.

The following options are available when defining a Go InDirv motion:
Drive element type: line or angle.
Angle of drive, if drive element type is angle.
Drive direction: Same or Inverted.
This is useful in the particular case when two positions are reachable.
Control over geometric extrapolation of check curve.
Normal thickness, and axial and radial offset with respect to the check element.
Feedrate and spindle speed.
Collision avoidance when the tool is positioned in TO or PAST mode.
Left and right safety angles when collision avoidance is used.
Machining tolerance
Tool compensation
Guiding Point, if a square or grooving insert is used.

Go Delta Motion 

In Go Delta motion, the tool move is based on the current position of the tool. The TO-ON-PAST mode
is not proposed. 

The following options are available when defining a Go Delta motion:



Delta check mode:
Distance between two points (two points are to be selected)
Line and distance (line and distance are to be selected)
Angle and distance (angle and distance are to be given)
Axial and radial (axial and radial offsets are to be given)

Feedrate and spindle speed.
Machining tolerance
Tool compensation.

Follow Motion 

In Follow motion, the tool follows a drive element up to a check element. The check element is to be
selected in the Follow motion and can be an edge, line, a curve or a point. 

The drive element is a curve on which the tool is positioned by a preceding motion. Therefore, the
preceding motion must be a Go, Go InDirv or Follow motion. A Go to a point or a Go Delta cannot
precede a Follow motion.

If the preceding motion is a Go motion, the first selected check curve is used as drive curve for the
Follow motion.

If the preceding motion is a Go InDirv motion, the selected check curve is used as drive curve for the
Follow motion.

If the preceding motion is a Follow motion, the check element of the preceding Follow motion is used
as drive curve when this check element is not a point and the Change Drive option of the preceding
Follow motion is set. Otherwise, both consecutive Follow motions share the same drive curve.

Note that:
the thickness and offsets applied to follow the drive element are also defined on the same
preceding motion. When the drive and check curves are tangent, any thickness and offset
values on the check curve should be the same on the tangent drive curve.
the collision avoidance and the control over geometry extrapolation on drive curve are also
defined on the same preceding motion.

The tool will follow the drive element up to the check element. The final tool position will be determined
by the TO-ON-PAST mode:
TO: tool nose tangent to the drive element and before the check element with a possible thickness or
offset.
ON: tool nose tangent to the drive element and on the check element, with a possible axial or radial
offset (normal thickness is not applicable).
PAST: tool nose tangent to the drive element and after the check element with a possible thickness or
offset.

The following options are available when defining a Follow motion:
Drive direction: Same or Inverted.
This is useful in the particular case when two positions are reachable.
Control over geometric extrapolation of check curve.
Normal thickness, and axial and radial offset with respect to the check element.
Feedrate and spindle speed.
Collision avoidance when the tool is positioned in TO or PAST mode.



Left and right safety angles when collision avoidance is used.
Machining tolerance
Tool compensation
Guiding Point, if a square or grooving insert is used.

Control over Geometric Extrapolation of Check Curve

When check limit mode is set to Extended, a virtual tangent element is added to each extremity of the
check element before it is actually taken into account as a check element. 
Therefore, if there is no intersection between the drive and check elements, the final tool position may
be located at the intersection of the drive curve and a tangent of the check element. 

When check limit mode is set to Actual, no virtual tangent element is added. 
Therefore, the final tool position is located on the check element. 

Furthermore, please note that control over geometric extrapolation is not controlled in the Follow
motion but on the preceding motion that positions the tool on the drive element.

Note that collision avoidance is taken into account for positioning in ON mode, and that left and right
safety angles are only considered in collision avoidance mode.

 

 



Cutter Compensation with Finish
Operations

The Cutter Compensation: None / On / Reverse option is proposed for finish operations. If this
option is set to On or Reverse, the NC output will include CUTCOM instructions in the APT or
clfile output for cutter compensation (CUTCOM/RIGHT, CUTCOM/LEFT, CUTCOM/OFF).

On: CUTCOM/RIGHT instruction generated if tool is to the right of the toolpath and
CUTCOM/LEFT if tool is to the left of the toolpath
Reverse: CUTCOM/RIGHT instruction generated if tool is to the left of the toolpath and
CUTCOM/LEFT if tool is to the right of the toolpath.

Otherwise, if the option is set to None, no CUTCOM instruction will be included in the NC data
output. 

A CUTCOM instruction is always generated before a linear trajectory in order to be active on that
displacement:

for a tool approach, the instruction CUTCOM/RIGHT or CUTCOM/LEFT is generated at
latest in the approach phase of the trajectory, before the lead-in and on a linear trajectory
for a tool retract, the instruction CUTCOM/OFF is generated at earliest in the retract
phase of the trajectory, before a linear trajectory or the last point of the operation.

The figure below illustrates a Profile Finishing operation that has circular lead-in and linear
lift-off. 

If the cutter compensation is set to ON, the CUTCOM instructions are generated as follows:



CUTCOM/RIGHT is generated at point 1, before the tool motion to point 2.
Note that if lead-in was linear, CUTCOM/RIGHT would be generated at point 2, before the
tool motion to point 3.
CUTCOM/OFF is generated at point 4, before the tool motion to point 5.
Note that if lift-off was circular CUTCOM/OFF would be generated at point 5, before the
linear retract motion.

How to Use Cutter Compensation
The computed toolpath corresponds to the trajectory followed by the output point of the tool used
in the Part Operation. You should set Cutter Compensation to On in the following cases:

the cutter radius of the actual tool used for machining is greater than the radius of the
programmed tool and a positive compensation value is entered at the NC machine
the cutter radius of the actual tool used for machining is less than the radius of the
programmed tool and a negative compensation value is entered at the NC machine.

You should set Cutter Compensation to Reverse in the following cases:
the cutter radius of the actual tool used for machining is less than the radius of the
programmed tool and a positive compensation value is entered at the NC machine
the cutter radius of the actual tool used for machining is greater than the radius of the
programmed tool and a negative compensation value is entered at the NC machine.

Some Recommendations 
In general you should program with tools whose cutter radius is greater than those that will
actually be used on the machine. This will help you anticipate tool/part collisions that may arise
when cutter compensation is used. If negative compensation values are allowed on the machine,
set Cutter Compensation to On. If negative compensation values are not allowed on the machine
set Cutter Compensation to:

On, if the tool actually used has a greater cutter radius than the programmed tool
Reverse, if the tool actually used has a smaller cutter radius than the programmed tool.

The figure below illustrates cutter compensation for profile finishing. 



 

  



Changing the Output Point
An option for changing the tool output point is available for: 

Recessing, Grooving and Groove Finishing operations using grooving tools or inserts
certain Threading operations using threading tools or inserts.

When the  Change Output Point option is set the tool output point will be changed automatically
during the operation according to the profile geometry to be machined. 

For Grooving and Groove Finishing operations, tool output point changes are made out of the
profile. 

For Recessing operations, tool output point changes are made before each tool motion involving
machining (that is, after each plunge). However, changes are only done:

if machining is consistent with the selected tool output point
if another output point is defined on the tool so that the tool output point change can be
made.

Otherwise, the tool output point will not be changed. 

The following figure illustrates tool output point changes in a Groove Finishing operation that
uses a grooving tool. In this example, at the start of operation the tool output point is P9. 



If the first flank to machine is flank 1, the tool motion is as follows:
approach and lead-in motion to flank 1
machine down flank 1
lift-off from part profile
tool output point change: tool output point is P9R
approach and lead-in motion to flank 2
machine down flank 2
lift-off to Exit Point
tool output point change: tool output point is P9 (as at start of operation).

If the first flank to machine was flank 2, the tool motion would be as follows:
tool output point change: tool output point is P9R
approach and lead-in motion to flank 2



machine down flank 2
lift-off from part profile
tool output point change: tool output point is P9 and the guiding point is LEFT
approach and lead-in motion to flank 1
machine down flank 1
lift-off to Exit Point.

If P9 is the tool output point and if the output point P9R is defined on the tool, the output point
change is only done for grooving tools.

The tool output point at the end of operation is the same as at the start of operation.

The figure below illustrates a Recessing operation when a round insert is used. The tool output
point changes during an operation only if the output point at the start of operation is P2, P3 or P9
for a frontal recess or P3, P4 or P9 for an external recess.

The tool output point is dependent on the machine axis system.

 

  



Lathe Tool Assembly Conventions
General Comments
The Machining Axis is always a direct axis system. For example, ZX defines a direct axis system with Z as
the Spindle Axis and X as the radial axis.

Selected geometry (for example, Finish Profile) can be selected either in X+ or X- :
the system will figure out whether machining is in X+ or X- based on Insert-Holder orientation (as
defined using Set-Up Angle)
depending on the options of a Machining Operation, several possibilities might exist,
(for example, Frontal machining). User option is then available (X+/X-) to specify what the system
should do.

The Output Point definition is considered according to the X+/Z+ quadrant.

Examples below deal with Horizontal Lathe Machine Tool.

 

Insert Holder
Different settings of the Setup Angle, Invert Tool and Hand Style parameters result in different
configurations for positioning the tool .
Left Tool: Insert is visible and points to left: Inverted Left Tool :

 



Right Tool: Insert is visible and points to right: Inverted Right Tool:

 

 

Output Point
In the following figure reference is made according to the Spindle/Radial Axis (Z/X)

 

Spindle Rotary Direction
With a Horizontal Lathe Machine Tool the convention for spindle rotary direction defined in the Machine
Editor dialog box is as follows:
Looking into Z direction, Chuck & Jaws at your back.



Clockwise Counterclockwise

The following represent common settings:

 

180° Setup Angle
When Setup angle is set to180°, machining takes places in X- as system detects that this is what the tool
can machine (geometry can be selected in X+ or X-).

 



Direct Machining Axis
As the Machining Axis is always considered as being direct, the two situations below are the same (this
corresponds to a rotation around the spindle axis).

 

Summary
The following figures summarize conditions for lathe tool assemblies.



The figure below shows other settings for different output points.



 

  



How to Use Actual Stock Computation
When you want to select the stock and part of a new machining operation, you can create the Actual Stock from
the current operation. 

This is done using the Actual Stock Computation command in the geometry tab page. The Actual Stock
computation can be launched before the part or stock selection to create a sketch putting in emphasis the
remaining material on the part. The computation takes into account all complete operations before the one which
is edited.

The computation of the Actual Stock uses the "Stock for simulation", that you have to select in the Part Operation
panel. The primitives of the material removed by each lathe operation will be subtracted from this stock.

The result of the computation is a sketch which contains the view of the remaining material in the working plane. 

The first step before using Actual Stock Computation is to select a stock for simulation.

Double click on the Part Operation icon and select  the Stock icon in the Part Operation dialog box. 

Select the stock, then double click on the background to leave selection mode.



The Part Operation panel shows the name of the selected stock. In order to use Actual Stock Computation, you
must select a lathe machine. The spindle and radial machine must be initialized correctly.



The second step is to initialize the In-Process Model body (IPM body) in the Part Operation panel. 

The actual stock contour will be computed inside this body.  Select a Part linked to your Product (or use "Insert a
New Part" in the Assembly workbench on your existing product). 

Double click on the part to enter the Part Design workbench and use the Insert > Body command to create a new
body in your part. In this sample, call it "IPM_BODY".

The created "IPM_BODY" body will be put in "No Show" mode after the Actual Stock computation.  So do not
use an existing body otherwise your existing geometry will be in the No Show layer after the computation.



To summarize:

The setup for the computation, we need to define in Part Operation panel:
a Lathe Machine with its spindle and radial axis initialized
a Stock for simulation (solid) selected in the Part Operation panel
an In Process Model body created inside an existing or newly created Part.

The operations taken into account by the Actual Stock computation are:
Lathe Operations:

Roughing
Grooving
Recessing
Profile Finishing
Groove Finishing.

All Drilling operations using a "fixed" Tool Assembly are taken into account. For this, select the Assembly
tab page and click on More. In the Technology tab page the parameter "Power" must be set to "Fixed".

Lathe Threading operations are not taken into account for Actual Stock computation.

Example of Actual Stock Computation
The following figure illustrates the launching of the Actual Stock computation after a Drilling (with fixed Tool



assembly) and a Roughing operation. Here is the tool path of the roughing operation: 

If you want to create another Roughing operation after the first one, click "Actual Stock computation" in the new
Roughing operation's Geometry tab page. 

The following figure shows the result of the computation. The Actual Stock has been created in blue. It is inside a
sketch whose name is the name of the last machining operation taken into account for the computation:
Roughing.1 plus the item StockSketch and the time of the computation. You can see that the Actual Stock sketch
has been created in a body with the same name, just under the "IPM body". The "IPM body" is now in No Show
mode.



You can now select elements of the Actual Stock sketch as new Part or new Stock item of the Roughing.2
operation.

To create the Actual Stock, some primitives are created inside the IPM body. Once the Actual Stock sketch is
created, the Actual Stock sketch is no longer linked to them.  If you use the Actual Stock computation again, the
existing primitives will speed up the computation (they will be used if the operation they are linked with have not
been been modified since the first call to Actual Stock, otherwise they will be modified). This command will not
remove the Actual Stock sketches or the IPM body.

To manage different Actual Stock sketches, you can change the color of each sketch by modifying the graphic
property of the sketch.

If you have finished your Part Operation, you can remove these primitives by using the Remove IPM primitives
contextual command on the Manufacturing Program. This command will remove each primitive of the IPM body
linked to the operation inside the program.

 



 



Glossary
A

approach
macro

Motion defined for approaching the operation start point

auxiliary
command

A control function such as tool change or machine table rotation. These
commands may be interpreted by a specific post-processor.

axial
machining
operation

Operation in which machining is done along a single axis and is mainly
intended for hole making (drilling, counter boring, and so on). 

D
DPM Digital Process for Manufacturing.

E
extension
type

Defines the end type of a hole as being through hole or blind.

F
feedrate Rate at which a cutter advances into a work piece.

Measured in linear or angular units (mm/min or mm/rev, for example).
fixture Elements used to secure or support the workpiece on a machine.

G
gouge Area where the tool has removed too much material from the workpiece.

M
machine
rotation

An auxiliary command in the program that corresponds to a rotation of the
machine table.

machining
axis system

Reference axis system in which coordinates of points of the tool path are
given.

machining
operation

Contains all the necessary information for machining a part of the workpiece
using a single tool.

machining
tolerance

The maximum allowed difference between the theoretical and computed tool
path.



manufacturing
process

Defines the sequence of part operations necessary for the complete
manufacture of a part.

manufacturing
program

Describes the processing order of the NC entities that are taken into account
for tool path computation: machining operations, auxiliary commands and PP
instructions.

O
offset Specifies a virtual displacement of a reference geometric element in an

operation (such as the offset on the bottom plane of a pocket, for example). 
Compare with thickness. 

one way Machining in which motion is always done in the same direction. Compare with
zig zag.

P
part operation Links all the operations necessary for machining a part based on a unique part

registration on a machine. The part operation links these operations with the
associated fixture and set-up entities.

PP instruction Instructions that control certain functions that are auxiliary to the tool-part
relationship. They may be interpreted by a specific post processor.

PPR Process Product Resources.

R
retract macro Motion defined for retracting from the operation end point

S
safety plane A plane normal to the tool axis in which the tool tip can move or remain a

clearance distance away from the workpiece, fixture or machine.
set up Describes how the part, stock and fixture are positioned on the machine.

spindle speed The angular speed of the machine spindle.
Measured in linear or angular units (m/min or rev/min, for example).

stock Workpiece prior to machining by the operations of a part operation.

T
thickness Specifies a thickness of material to be removed by machining. Compare with

offset.



tool axis Center line of the cutter.

tool change An auxiliary command in the program that corresponds to a change of tool.

tool clash Area where the tool collided with the workpiece during a rapid move.

tool path The trajectory that the tool follows during a machining operation.

total depth The total depth including breakthrough distance that is machined in a hole
making operation.

U
undercut Area where the tool has left material behind on the workpiece.

Z
zig zag Machining in which motion is done alternately in one direction then the other. 

Compare with one way.
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Angle of Incline

Groove Finishing parameter 

Grooving parameter 

Recessing parameter 

APT import 

APT source generation 
Attack

Grooving parameter 

Recessing parameter 

Roughing parameter 
Auxiliary operation

Copy Transformation 

Machine Rotation 

Machining Axis or Origin 

PP Instruction 

Tool Change 
Axial Depth of Cut

Recessing parameter 

Roughing parameter 
Axial Limit for Chuck Jaws

Roughing parameter 
Axial offset on part

Groove Finishing parameter 

Grooving parameter 



Profile Finishing parameter 

Recessing parameter 

Roughing parameter 

C

CGR file generation 
Change Output Point

Groove Finishing parameter 

Grooving parameter 

Recessing parameter 

Threading parameter 
Chip Break

Grooving parameter 
Clearance

Groove Finishing parameter 
Clearance on crest diameter

Threading parameter 
Clearance on stock

Grooving parameter 

Recessing parameter 

Roughing parameter 

Clfile code generation 
Contouring for Outside Corners

Groove Finishing parameter 

Profile Finishing parameter 

Copy-Transformation Instruction 
Corner Processing

Groove Finishing parameter 



Profile Finishing parameter 
CUTCOM

Groove Finishing parameter 

Profile Finishing parameter 

D
Depth of cut

Threading parameter 

direct axis system 

direct machining axis system 

Documentation generation 

E

Edit Parameters dialog box  
End Limit

Groove Finishing parameter 

Profile Finishing parameter 

Roughing parameter 

Threading parameter 
End Limit Clearance

Groove Finishing parameter 

Profile Finishing parameter 

Roughing parameter 

Threading parameter 

External Groove Finishing 

External Grooving 



External Profile Finishing 

External Recessing 

External Roughing 

External Threading 

F
Face

Roughing mode  

Face Roughing  
Feeds and Speeds

Groove Finishing parameter 

Grooving parameter 

Profile Finishing parameter 

Recessing parameter 

Roughing parameter 
First passes

Threading parameter 
First Plunge

Grooving parameter 
Follow

Sequential Machining motion 

Follow Tool Motion 

Frontal Groove Finishing 

Frontal Grooving 

Frontal Profile Finishing 

Frontal Recessing 

Frontal Roughing 



G
Go Delta

Sequential Machining motion 

Go Delta Motion 
Go InDirv

Sequential Machining motion 

Go InDirv Tool Motion 
Go Standard

Sequential Machining motion 

Go Standard Tool Motion 
Go-Go

Sequential Machining motion 

Go-Go Tool Motion 
Gouging Safety Angle

Grooving parameter 

Recessing parameter 

Groove Finishing operation  
Groove Finishing parameter

Angle of Incline 

Axial offset on part 

Change Output Point 

Clearance 

Contouring for Outside Corners 

Corner Processing 

CUTCOM 

End Limit 

End Limit Clearance 

Feeds and Speeds 



Lead-in 

Lift-off 

Machining Direction 

Machining Tolerance 

Orientation 

Overlap 

Radial offset on part 

Start Limit 

Start Limit Clearance 

Thickness on part 

Tool Compensation 

Under Spindle Axis Machining 
Grooving by Level

Grooving parameter 

Grooving operation  
Grooving parameter

Angle of Incline 

Attack 

Axial offset on part 

Change Output Point 

Chip Break 

Clearance on stock 

Feeds and Speeds 

First Plunge 

Gouging Safety Angle 

Grooving by Level 

Lead-in 

Lift-off 



Machining Tolerance 

Maximum Depth of Cut 

Next Plunges 

Orientation 

Part Contouring 

Radial offset on part 

Thickness on part 

Tool Compensation 

Under Spindle Axis Machining 

I

Inclined Groove Finishing 

Inclined Grooving 

Inclined Recessing 

insert holder 

Internal Groove Finishing 

Internal Grooving 

Internal Profile Finishing 

Internal Recessing 

Internal Roughing 

Internal Threading 

L
Last passes

Threading parameter 
Lead-in



Groove Finishing parameter 

Grooving parameter 

Profile Finishing parameter 

Recessing parameter 

Roughing parameter 

Threading parameter 
Leading Safety Angle

Profile Finishing parameter 

Recessing parameter 

Roughing parameter 
Lift-off

Groove Finishing parameter 

Grooving parameter 

Profile Finishing parameter 

Recessing parameter 

Roughing parameter 

Threading parameter 

Local Information  
Location

Profile Finishing parameter 

Roughing parameter 

Threading parameter 
Longitudinal

Roughing mode  

Longitudinal Roughing  



M

Machine Rotation 

Machining Axis or Origin 
Machining Direction

Groove Finishing parameter 

Profile Finishing parameter 

Recessing parameter 

Roughing parameter 

Machining Process, Apply 

Machining Process, Create 
Machining spindle speed

Threading parameter 
Machining Tolerance

Groove Finishing parameter 

Grooving parameter 

Profile Finishing parameter 

Recessing parameter 

Roughing parameter 

Manufacturing Program 
Maximum Depth of Cut

Grooving parameter 

Recessing parameter 

Roughing parameter 
Maximum Machining Radius

Roughing parameter 
Minimum Machining Radius

Roughing parameter 



N

NC code generation 
Next Plunges

Grooving parameter 
Nominal diameter

Threading parameter 
Number of passes

Threading parameter 
Number of threads

Threading parameter 

O
One Way

Recessing mode 

One Way Recessing 
Orientation

Groove Finishing parameter 

Grooving parameter 

Profile Finishing parameter 

Recessing parameter 

Roughing parameter 

Threading parameter 

output point, definition 

output point, examples 
Overlap

Groove Finishing parameter 



P
Parallel Contour

Recessing mode 

Roughing mode  

Parallel Contour Recessing 

Parallel Contour Roughing  
Part Contouring

Grooving parameter 

Recessing parameter 

Roughing parameter 

Part Operation 
Plunge

Recessing parameter 
Plunge Angle

Roughing parameter 
Plunge Distance

Roughing parameter 

PP Instruction 

Process List 

Product List 

Profile Finishing operation  
Profile Finishing parameter

Axial offset on part 

Contouring for Outside Corners 

Corner Processing 

CUTCOM 

End Limit 

End Limit Clearance 



Feeds and Speeds 

Lead-in 

Leading Safety Angle 

Lift-off 

Location 

Machining Direction 

Machining Tolerance 

Orientation 

Radial offset on part 

Recess Machining 

Start Limit 

Start Limit Clearance 

Thickness on part 

Tool Compensation 

Trailing Safety Angle 

Under Spindle Axis Machining 

R
Radial Depth of Cut

Recessing parameter 

Roughing parameter 
Radial offset on part

Groove Finishing parameter 

Grooving parameter 

Profile Finishing parameter 

Recessing parameter 

Roughing parameter 



Recess Machining

Profile Finishing parameter 

Roughing parameter 
Recessing mode

One Way 

Parallel Contour 

Zig Zag 

Recessing operation  
Recessing parameter

Angle of Incline 

Attack 

Axial Depth of Cut 

Axial offset on part 

Change Output Point 

Clearance on stock 

Feeds and Speeds 

Gouging Safety Angle 

Lead-in 

Leading Safety Angle 

Lift-off 

Machining Direction 

Machining Tolerance 

Maximum Depth of Cut 

Orientation 

Part Contouring 

Plunge 

Radial Depth of Cut 

Radial offset on part 



Thickness on part 

Tool Compensation 

Trailing Safety Angle 

Under Spindle Axis Machining 

Resources List 

rotary direction 
Roughing mode

Face  

Longitudinal  

Parallel Contour  

Roughing operation 
Roughing parameter

Attack 

Axial Depth of Cut 

Axial Limit for Chuck Jaws 

Axial offset on part 

Clearance on stock 

End Limit 

End Limit Clearance 

Feeds and Speeds 

Lead-in 

Leading Safety Angle 

Lift-off 

Location 

Machining Direction 

Machining Tolerance 

Maximum Depth of Cut 

Maximum Machining Radius 



Minimum Machining Radius 

Orientation 

Part Contouring 

Plunge Angle 

Plunge Distance 

Radial Depth of Cut 

Radial offset on part 

Recess Machining 

Thickness on part 

Tool Compensation 

Trailing Safety Angle 

Under Spindle Axis Machining 

S
Sequential Machining motion

Follow 

Go Delta 

Go InDirv 

Go Standard 

Go-Go 

Sequential Machining operation  

setup angle, 180° 

Simulate material removal 

spindle rotary direction 
Spring passes

Threading parameter 
Start Limit



Groove Finishing parameter 

Profile Finishing parameter 

Threading parameter 
Start Limit Clearance

Groove Finishing parameter 

Profile Finishing parameter 

Threading parameter 

T
Thickness on part

Groove Finishing parameter 

Grooving parameter 

Profile Finishing parameter 

Recessing parameter 

Roughing parameter 
Thread depth

Threading parameter 
Thread length

Threading parameter 
Thread Penetration type

Threading parameter 
Thread pitch

Threading parameter 
Thread profile

Threading parameter 
Thread unit

Threading parameter 

Threading operation  
Threading parameter



Change Output Point 

Clearance on crest diameter 

Depth of cut 

End Limit 

End Limit Clearance 

First passes 

Last passes 

Lead-in 

Lift-off 

Location 

Machining spindle speed 

Nominal diameter 

Number of passes 

Number of threads 

Orientation 

Spring passes 

Start Limit 

Start Limit Clearance 

Thread depth 

Thread length 

Thread Penetration type 

Thread pitch 

Thread profile 

Thread unit 

Threading type 

Threads/inch 

Tool Compensation 
Threading type



Threading parameter 
Threads/inch

Threading parameter 
Tool Assembly in Resource List

edit  

Tool Change 
Tool Compensation

Groove Finishing parameter 

Grooving parameter 

Profile Finishing parameter 

Recessing parameter 

Roughing parameter 

Threading parameter 
tool in operation

edit or select another 
tool in resource list

edit 

Tool path replay 

tool positioning 
Trailing Safety Angle

Profile Finishing parameter 

Recessing parameter 

Roughing parameter 

U
Under Spindle Axis Machining

Groove Finishing parameter 

Grooving parameter 



Profile Finishing parameter 

Recessing parameter 

Roughing parameter 

Z
Zig Zag

Recessing mode 

Zig Zag Recessing 
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